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Introduction 

About Assyst Real Estate 
Assyst Real Estate 

solution that simplifies and streamlines the way a mortgage transaction is instructed, processed and 

reported. 

With Assyst Real Estate, lawyers/notaries and their staff complete mortgage files more efficiently and 

with fewer errors, saving valuable time and money. Participating lenders using Assyst Real Estate 

deliver mortgage instructions directly to the desktop of a lawyer/notary. As those mortgage terms are 

pre-populated and locked-

Mortgage 

Forms, Schedules and Standard Charge Terms are available within the electronic file, eliminating the 

need to search the Internet to download documents. Mortgage terms can be frozen 48 hours before 

closing, eliminating frustrating last minute changes. The Preliminary Report is submitted online, 

signed by a lawyer/notary using a digital signature. Depending on the province, Assyst Real Estate 

complements or facilitates the electronic registration of mortgages. Once the mortgage transaction is 

closed, the Final Report is also delivered to the lender online, signed by a lawyer/notary using a digital 

signature, without enclosures or attachments in most cases.   

 

Designed by the legal community for the legal community, it allows lawyers/notaries and their legal 

assistants to complete a mortgage transaction in the usual manner, without affecting their workflow. 

Assyst Real Estate so unique  

About this Guide 

Content 

The Assyst Real Estate Reference Guide is a manual intended to present in details Assyst Real 

Estate and its functions. It was elaborated so as to allow a progressive approach while respecting 

the working procedure of lawyers and notaries. 

This Guide is divided into the following sections and appendices: 
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 Section 1: Getting Started 

This section introduces the basic steps to be followed to access Assyst Real Estate and 

familiarize the user with the application and its interface. 

 Section 2: Managing the System 

This section presents the tools available to the lawyer/notary, to manage his profile and his 

personal information and the transaction reports when working with Assyst Real Estate files. 

 Section 3: Using the System 

This section explains in details how to use the application and the Assyst Real Estate file 

management functions. 

Intended Audience 

The Assyst Real Estate Reference Guide is intended to the lawyers and notaries in Canada who will 

use Assyst Real Estate. This guide is designed both for lawyers/notaries and their legal assistants. 

Features that are only addressed to a lawyer/notary or to a legal assistant are clearly identified. 

A minimal knowledge of computers, Windows and the Internet is required to be able to progress in 

the learning and the use of Assyst Real Estate with this manual. 

Conventions 

Symbol Definitions 

This guide uses some conventions intended to facilitate its reading and its understanding. The 

following conventions are used in this guide: 

Symbol Meaning / Used for 

Bold Application Name, Window Name, Command Name, Link 

Name, Button Name, Icon Name, Field Name, File or Directory 

Name, Text entered by the user 

Small  Caps Refers to keyboard keys   

1.  Introduce a numbered list or  a step in a procedure 

  Introduces a procedure to follow 

  Introduces a list of elements 

  Introduces a warning information  when using the system 
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Mouse Conventions 

This guide used the following conventions related to the mouse usage: 

Button or action Meaning 

Left button Main mouse button used by default 

Right button Alternative button used in particular situations  

Position Refers to positioning the mouse pointer at a specific location. 

Click Refers to pressing down the mouse button then releasing it 

Double-click Refers to rapidly pressing the mouse button twice 

 

Getting Support 
Getting Support 

To access Assyst Real Estate, go to https://acces.assystimmobilier.com/rei.  A User Name and 

Password issued by TELUS are required.  Both are case sensitive.  

Some documents in Assyst Real Estate require the use of the . To download a 

free version of the latest , please visit www.adobe.com.   

For questions regarding the use of Assyst Real Estate, or for any technical information, please 

contact the TELUS Service Desk. 

TELUS Service Desk: 1-877-418-7511 

E-mail: RealEstateSupport@telus.com 

Please send comments and suggestions to this address as well. 

  

https://acces.assystimmobilier.com/rei
../www.adobe.com
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Chapter 2 - Accessing the Assyst Real Estate 

Chapter 3 - Getting Stated with the Assyst Real Estate 
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Chapter 1 
Setting Up Assyst Real Estate 

The objective of this chapter is to present the minimal configuration required for Assyst Real Estate 

to function properly and the procedure to be followed to make sure you have the correct version of 

Internet Explorer. You will also find in this chapter the procedure to be followed to modify your 

Internet Explorer configuration to get the appropriate level of security to be able to login to Assyst 

Real Estate. 

Recommended Configuration 
Following are the minimal installation requirements to ensure Assyst Real Estate will function 

properly and to be able to get support if needed. 

 Pentium-compatible processor (Pentium III 500 MHz or higher recommended) 

 256 MB available RAM  

 10 GB of free hard disk 

 256-color monitor capable of 1024 x 768 screen resolution 

 Microsoft Windows XP 

 Microsoft Word 2000 and Office 2000 with the Office updates equal or superior to 2000. 

 Internet Explorer 6.0 

 Adobe Reader 8 or superior 

 Printer 

 High-speed Internet connection 

 Digital signature issued by the Certificate Authority designated by TELUS. 

 

Checking your Configuration 
Assyst Real Estate provides a diagnostic function to check that your computer configuration is in 

accordance with the minimum requirements and detect any configuration problem. This diagnostic is 

done on your computer prior to logging into the system. 

In case of technical problems, you will use the diagnostic function to send your computer's 

configuration information to the TELUS Service Desk. 
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 To execute the configuration checking process 

1. Start Internet Explorer and enter the Assyst Real Estate URL link to display the Assyst Real 

Estate login page. 

Refer to the Assyst Real Estate URL Link section for more details on accessing the Assyst 

Real Estate login page. 

2. In the Assyst Real Estate login page, select the Diagnostic link. This will open the 

Diagnostic page. 

 

3. Click the Please click here to begin the checking process link to start the diagnostic process 

on your computer.  

A list of information to be checked is displayed. The diagnostic will go through every point 

and the result of the verification process is progressively displayed on the right of every 

configuration element. 

A message is displayed at the end of the checking process. 

4. Enter your User Name, Name and Phone Number in the appropriate fields and click the 

Send the information to our Service Desk if necessary if you need to transfer the information 

to get support. 

A confirmation message is displayed.  

5. Click the Back to Login Page link to go back to the login page. 
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Verifying the Internet Explorer Version 
To be able to work with Assyst Real Estate, you must have installed Internet Explorer version 6.0 or 

higher. The objective of this section is to show you the process to verify you have the correct Internet 

Explorer version installed on your computer. 

 To verify the Internet Explorer version on your computer  

1. Start Internet Explorer by clicking the Internet icon on your desktop. The Internet Explorer 

window is displayed. 

2. In the Help menu (?), select About Internet Explorer. This will open the About Internet 

Explorer window.  

 
 

3. Check the version number indicated in the Version field. This number corresponds to the 

version installed on your computer. 

  

4. Click OK to close the About Internet Explorer window. 
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5. If the recommended version is not installed on your computer, you can download it from:  

http://www.microsoft.com/downloads.  

This link opens the Microsoft Download Center site. 

6. In the Search for a Download section, for the Keywords field, enter: Internet Explorer. 

 

7. Click Go to run the search. 

8. Once the search is completed, select the version you want to install. Usually, the first file 

found in the search corresponds to the latest available version. Follow the instructions to 

download and install this version of Internet Explorer.  

Modifying the Internet Explorer Security 
To avoid to receive continual warnings on the ActiveX execution and to be able to open Microsoft 

Word documents from Assyst Real Estate, you have to save the TELUS site as a trusted site and to 

configure its security level in Internet Explorer. The procedure below aims at explaining you how to 

do these operations. 

 To modify the Internet Explorer security 

1. Start Internet Explorer by clicking the Internet icon on your desktop. The Internet Explorer 

window is displayed. 

2. From the Tools menu, select Internet Options. This will open the Internet Options window. 

3. In the Internet Options window, click the Security tab. 

http://www.microsoft.com/downloads
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4. Select the Trusted sites icon. 

 

5. Click the Sites button. This will open the Trusted sites window. 

 

6.  In the Add this Web site to the zone field, enter: assystrealestate.com. 
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7. Uncheck the Require server verification (https:) for all sites in this zone check box. 

 

8. Click the Add button.  

 

The assystrealestate.com web site is added to the Web sites list.  

 

9. Check the Require server verification (https:) for all sites in this zone check box. 

10. Click OK to close the Trusted sites window. This will display again the Internet Options 

window. 

11. Click the Default Level button. This will display the parameters for the default security level. 

 Make sure that the Trusted sites icon is always selected. 

12. Click OK to close the Internet Options window. 

This completes the procedure to modify the Internet Explorer security parameters. You should now 

be able to login to Assyst Real Estate without any problem. 



 

 19 
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Chapter 2 
Accessing Assyst Real Estate 

The objective of this chapter is to present the first steps to be followed to login to Assyst Real 

Estate: how to use the Assyst Real Estate link and how to identify yourself using your user name and 

password. You will also find in this chapter a description of the options available in the login page and 

the ways passwords are managed in the system.  

Note: The explanations given in this chapter do not apply to users connected to Assyst Real Estate 

through BC online. 

Accessing Assyst Real Estate 
You access Assyst Real Estate through an Internet connection using the Assyst Real Estate URL 

(Universal Resource Locator). You will thus access Assyst Real Estate the same way you already 

access other Internet sites on the Web by entering the specific Assyst Real Estate address in your 

Internet Explorer browser.  

Assyst Real Estate URL Link 

 To access Assyst Real Estate 

1. Start Internet Explorer by clicking the Internet icon on your desktop. The Internet Explorer 

window is displayed. 

2. In the Address section, enter the Assyst Real Estate address: 

https://login.assystrealestate.com/rei/ 

 

3. Press Enter on your keyboard or click the GO button on the right of the Address field 

(Internet 6.0). 

https://login.assystrealestate.com/rei/
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This will display the Assyst Real Estate login page in your Internet browser.   

  

 

In this page, you enter your user name and password to identify yourself and to log into the 

application and consult your data. Refer to the Logging in to Assyst Real Estate section for more 

details. 

  If you have problems to display the login page or if an error message is prompted, verify that 

the configuration of your workstation corresponds to the criteria described in the Erreur ! 

Source du renvoi introuvable. section. If the problem persists, contact the TELUS Service 

Desk. 

Quick Accesses to Assyst Real Estate 

The following section introduces two different methods you can use to easily access Assyst Real 

Estate without having to enter every time the Assyst Real Estate URL address: either by adding a 

shortcut to your Windows desktop or by adding a link to your Internet favorites. 
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Adding the Assyst Real Estate Shortcut to Your Desktop  

Your Windows desktop is the place where you display the icons of the applications you use the most 

frequently and the ones you want to access quickly. By double-clicking an icon on your desktop, you 

immediately execute the application associated to the icon. 

Adding thus the Assyst Real Estate shortcut to your Windows desktop allows you to quickly access 

the Assyst Real Estate icon and launch the application. 

 To add the Assyst Real Estate Shortcut to your desktop 

1. Start Internet Explorer by clicking the Internet icon on your desktop. The Internet Explorer 

window is displayed. 

2. In the Address section, enter the Assyst Real Estate address: 

https://login.assystrealestate.com/rei/ 

 

3. Press Enter on your keyboard or click the GO button on the right of the Address field 

(Internet 6.0).  

This will display the Assyst Real Estate login page in your Internet browser. 

4. Internet 6.0: In the File menu, select Send then the Shortcut to Desktop option. 

Internet 7.0: right-click anywhere in the web page and select Create Shortcut. 

The Assyst Real Estate shortcut is added to your desktop.  

 

 Close the Internet Explorer window and minimize all the other opened windows if you want to 

see your desktop. 

Every time you will want to access Assyst Real Estate, you will just have to double-click the Assyst 

Real Estate icon on your desktop to display the Assyst Real Estate login page. 

Adding the Assyst Real Estate link to Your Internet Favorites 

Your Internet favorites group your most frequently used links that you want to access quickly. 

https://login.assystrealestate.com/rei/
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Adding the Assyst Real Estate link to your Internet favorites will allow you to access Assyst Real 

Estate quickly without entering every time the Assyst Real Estate URL in your Internet browser as the 

link will be already memorized. 

 To add the Assyst Real Estate link to your Internet favorites  

1. Start Internet Explorer by clicking the Internet icon on your desktop. The Internet Explorer 

window is displayed. 

2. In the Address section, enter the Assyst Real Estate address: 

https://login.assystrealestate.com/rei/ 

 

3. Press Enter on your keyboard or click the GO button on the right of the Address field 

(Internet 6.0). This will display the Assyst Real Estate login page in your Internet browser. 

4. Internet 6.0: In the Favorites menu, select Add to Favorites.  

Internet 7.0: right-click anywhere in the Web page and select Add to Favorites or select the 

Add to Favorites icon. 

This will open the Add Favorite dialog box. 

The name of the Assyst Real Estate Web page is displayed in the Name field. 

  

5. Click the OK button (Internet 6.0) or Add button (Internet 7.0) to confirm you want to add the 

link to the Assyst Real Estate site to your favorites. The Assyst Real Estate address is then 

available in your favorites list. 

Every time you will want to access Assyst Real Estate, you will just have to select the link 

from the Favorites menu in the Internet Explorer browser.  

https://login.assystrealestate.com/rei/
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Logging in to Assyst Real Estate 
To be able to access your data in Assyst Real Estate, you first have to identify yourself with your 

user name and password. The system is then able to retrieve the information corresponding to your 

profile and display your data. 

Note: The explanations given in this section do not apply to users connected to Assyst Real Estate 

through BC online. 

First Login 

As a new user, you have received by e-mail your user code and temporary password to access 

Assyst Real Estate. You will have to enter them in the Assyst Real Estate login page to identify 

yourself. 

When you connect to Assyst Real Estate for the first time as a new user, the system asks you to 

change the temporary password which was assigned to you.  

You cannot login to Assyst Real Estate and consult your files as long as you have not changed your 

password. 

 To login to Assyst Real Estate for the first time 

1. Start Internet Explorer and enter the Assyst Real Estate URL link to display the Assyst 

Real Estate login page. 

2. Enter your user name and password in the User Name and Password fields.  
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3. Click Login. 

This will prompt a message indicating that your temporary password is expired. You have to 

enter a new password. You cannot login to Assyst Real Estate and consult your files as 

long as you have not changed your temporary password. 

4. Enter your new password in the New Password field. Your password must have between 6 

and 8 characters including two digits. 

5. Reenter your password in the Confirm New Password field. Make sure to respect capital 

and small letters. 

6. Click Login. 

If your login information is valid, the main Assyst Real Estate page is displayed and you can 

view the list of your files.  

Logging in to Assyst Real Estate 

It is from the Assyst Real Estate login page that you enter you user name and password to identify 

yourself and access the list of your files in the application.  

 To login to Assyst Real Estate 

1. Start Internet Explorer and enter the Assyst Real Estate URL link to display the Assyst 

Real Estate login page.   

  

2. Enter your user name and password in the User Name and Password fields.   
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3. Click Login.  

If your login information is valid, the main Assyst Real Estate page is displayed and you can 

view the list of your files. 

 If your password or your user name is erroneous, the system will prompt you and you will 

have to enter them again.   

 

 If your user name is valid but if you enter 3 times an incorrect password, the system will inform 

you that you exceeded the maximum number of attempts for your password and, for security 

reasons; your account will be automatically deactivated. You will have to contact in this case 

the TELUS Service Desk to reactivate your account. 

 If your user name is valid but has been deactivated for any reason, the system will inform you 

and you will have to contact the TELUS Service Desk. 

Selecting the Login Language 

Assyst Real Estate is available in two languages: English and French. You can decide at any time to 

change the current language even in the login page. 

 To select the login page language 

1. Start Internet Explorer and enter the Assyst Real Estate URL link to display the Assyst 

Real Estate login page. 

2. Click the Français link to display the login page in French. 

3. Click the English link from the French login page to go back to the English version.  
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Changing Your Password 

You can change your password at any time. The system will automatically ask you to change it after 

60 days. 

Your password is defined with your profile in Assyst Real Estate. You can modify it from the My 

Profile page which contains all the information relative to your profile. Refer to the Changing Your 

Password section for more details on the procedure to be change your password. 

Forgot Password? 

If you forgot your password, you can easily get a new temporary password by providing your e-mail 

address, which is defined in your profile. This e-mail address will then be used by the system to send 

you your new temporary password. 

 What to do if you forgot your password 

1. In the Assyst Real Estate login page, click the Forgot Password? link. 

This will display the Forgot Password? Window.   

 

2. In the E-mail field, enter your e-mail address as it is defined in your profile (in the Personal E-

mail field of the My Profile page).   
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3. Click the Send button. 

The system verifies your e-mail address and ensures it corresponds to the e-mail address 

defined in your profile in Assyst Real Estate (in the Personal E-mail field of the My Profile 

page).  

You will then receive two different e-mails at this address, one with your user name and one 

with your new temporary password. 

 If your e-mail address is invalid, the system will inform you and you will have to contact the 

TELUS Service Desk. 

 In the Forgot Password? window, click anytime the Cancel button if you wish to cancel the 

procedure and go back to the login page. 

Password Expiration 

For security reasons, your password is valid for a limited period of time. At the end of this period, your 

password is expired and not valid any more. 

Your password will automatically expire after a limited period of 60 days by default.  

In the 5 days preceding your password expiration, every time you will connect to Assyst Real Estate, 

the system will prompt you a message indicating the number of days remaining before the expiration 

delay and will suggest you to immediately modify your password or to do it during the next session. 

If you enter a password that is expired to attempt to login to Assyst Real Estate, the system will ask 

you to enter a new password. You will not be able to login to Assyst Real Estate and consult your 

files as long as you will have not changed your password. 

 What to do if your password is expired 

When you password is expired, the system prompts a message indicating that your password is 

expired. You have to enter a new password in this case. 
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1. Enter your new password in the New Password field. Your password must have between 6 

and 8 characters including two digits. 

2. Reenter your password in the Confirm New Password field. Make sure to respect capital 

and small letters. 

3. Click Login. 

If your login information is valid, the main Assyst Real Estate page is displayed and you can 

view the list of your files. 

Accepting the Agreement 

 Agreement acceptation step 

When you connect to Assyst Real Estate for the first time as a new user, the Service Agreement 

window where the Services agreement for the use of Assyst Real Estate is displayed. You 

(lawyer/notary and assistants and other lawyers/notaries who have been delegated this right) have to 

accept this agreement as the first step in the acceptance process and to be able to continue.  
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1. Click the checkbox  and click the  link to 

accept the terms and conditions of this agreement. The Assyst Real Estate main page is 

displayed and you access the list of new files. 

2. Click the  link a message box appears confirming the request. If you confirm the 

action you return to the login page. 

3. You can print a copy of the Agreement by clicking the Print the document link at the bottom 

right side of the window. This will display the Print window. Click the Print button to start 

printing. 

 The Accept File window is closed. A soft copy of the agreement is automatically generated 

and kept in the list of documents available for this new file (see the Documents tab). 

 When you accept a new mandate, you can view the agreement by cliquing View Service 

Agreement button in the Accept File window. 
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Chapter 3 
Getting Started with Assyst Real 
Estate 

The objective of this chapter is to familiarize you with the Assyst Real Estate interface as well as with 

the navigation methods within the interface. You will also find in this chapter a description of each 

element of the interface with its role and its functioning. This chapter also includes explanations on 

the basic functions of the application such as printing, accessing the help, searching files, sorting 

files, saving or canceling data modifications in a file, etc. 

It is recommended for you to read this chapter in detail to familiarize yourself with the Assyst Real 

Estate environment and functioning prior to read the other chapters. This chapter is intended for both 

lawyers/notaries and their legal assistants. Features that are specific to lawyers/notaries or to legal 

assistants are clearly identified. 

Discovering the Interface 
When you login to Assyst Real Estate, the Assyst Real Estate main page is displayed by default. 

You find in this page the list of your files on the left pane (or the list of files of the lawyer/notary you 

work with in the case of legal assistants or other lawyers/notaries who share files), the information 

associated with the currently selected file on the right pane and all the functions necessary to 

processing these files.  
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The Assyst Real Estate main page is made of the following components: 

 The tool bar on top of the window. Refer to the  

 

 Toolbar section for more details. 

 

 The list of your files (new and current files). Refer to the List of Files section for more details. 

 

For lawyers/notaries with no file 

sharing: 

For legal assistants or 

lawyers/notaries with file sharing: 
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 The file information page on the right pane that is organized into different tabs. Refer to the 

About New Files and Current Files sections for more details.  

 

 

Toolbar 

The toolbar displayed on top of the window includes a list of tools/functions available at any time 

when processing your files. 

Click one of the tool buttons to execute the corresponding function and open the associated page. 
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The functions available in the toolbar are the following:  

 My Profile: Function used to manage and consult the information relative to your profile 

(coordinates, address, password, alerts, payment information, etc.). 

Refer to the Managing Your Profile section for more details. 

 Transaction Report: Function used to generate a transaction report (invoices) over a given 

period of time. Refer to the Working with Transaction Reports section for more details. 

 Messages: Function used to consult the messages sent by TELUS. 

Refer to the Consulting the Messages from TELUS section for more details. 

 File Creation (for Quebec only): Function used to create a new file in order to import documents 

with bookmarks that you want to register online. Refer to the Creating Files section for more 

details. 

List of Files 

The list of files is always displayed on the left pane of the Assyst Real Estate main page. 

Organization and Description of the List of Files 

The list of files is organized as following: 

 New files (not yet accepted): They represent the files transmitted by the financial institutions and 

that you have to accept or refuse. They are the first to be displayed in your list of files and are 

green colored. For legal assistants and lawyers/notaries who share files, new files are displayed 

under the name of the lawyer/notary who is responsible for them. New files are displayed from 

the oldest to the most recently received. This sorting cannot be modified. 

For every new file, the TELUS file number and the borrower name are displayed as well as the 

number of remaining hours before the end of the acceptance period. 

Every new file is displayed during a limited period of time (2 business days); if, at the end of this 

delay, if you have not accepted or refuse a file, it is removed from your list of files and returned 

back to the financial institution. 

When you accept a file, it is removed from the list of your new files and moved to the list of your 

current files under the name of the financial institution which assigned it to you. If you refuse a file, 

it is removed from the list of your new files but the financial institution can reassign it to you. 
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List of new files (not yet 

accepted) displayed in green

(In case of file sharing new files are 

displayed under the name of 

the lawyer/notary responsible for them)
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 Current files (accepted): They represent the files you have already accepted and on which you 

work.  

They are organized by financial institution and they differ clearly from the new files by their blue 

color.  

For every financial institution, the number of available files is indicated to the right of the name of 

the institution. For legal assistants and lawyers/notaries who share files, current files are displayed 

under the name of the lawyer/notary who is responsible for them. 

For every file, the TELUS file number and the name of the borrower are displayed. 

Files are sorted out by TELUS file number or by borrower's name. This sorting can be modified by 

clicking the sorting arrow to the right of the file number or the borrower name. 

The files with notes that are not read are indicated in a different blue color and have a  symbol 

on their right side. The financial institutions that include files with notes that are not read also have 

a  symbol displayed on their right side. 

The file that is currently selected is highlighted in white in the list of files. 

The details of the file that is currently selected are displayed on the right pane. 

 

New Files 

When you select a new file (not yet accepted) in the list of files, the details of the new file are 

displayed on the right pane and includes the following information: 

List of current 

files per financial 

institution

Emergis file 

number
Borrower name

Number of files for the 

financial institution

File currently selected 

highlighted in white

Note symbol for the 

financial institution and 

the file (not yet read)

Number of remaining 

hours before the end of 

the acceptance period

Sort order

List of new files 

(displayed in green)

(In case of file sharing, files are 

displayed under the name of the 

lawyer/notary responsible for them))
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 One single tab called "New File". 

 The TELUS file number and the name of the borrower. 

 Information sections (general information, borrower, property, etc.). This information cannot be 

modified as long as the file is not accepted. 

 A section called "Accept or Refuse" where you find the options to accept or refuse the file. 

 

 

 Note 1: If you do not see all the information on your screen, use the vertical scroll bar on the 

right side of the window to display the information available at the bottom of your screen.  

 Note 2: New files are displayed under the name of the lawyer/notary who is responsible for 

them in case of file sharing (for legal assistants for instance). 

For more details on new files, refer to the Processing New Files section. 

Current Files 

When you select a current file (already accepted) in the list of files, the details of the file are displayed 

on the right pane and includes the following information: 

 4 tabs to manage efficiently the information: File, Additional Information, Documents, and 

Notes.  

 The TELUS file number and the name of the borrower. 

 Information sections (general information, borrower, property, etc.). This information can be 

modified if necessary. 

 A "Status" section where you can follow the file processing steps. 

 2 functions: Save and Cancel to be used to save or cancel the modifications you add to the file. 

File number

File currently selected 
Unique tab Borrower 

name
File information page

Functions to accept or 

refuse a file



Reference Guide  Assyst Real Estate 

 

40 

 

 If you do not see all the information on your screen, use the vertical scroll bar on the right side 

of the window to display the information available at the bottom of your screen. You will also 

find at the bottom of the File page a link called Top of Page. Click this link to go back quickly 

to the top of the page. 

 Current files are displayed under the name of the lawyer/notary who is responsible for them in 

case of file sharing (for legal assistants for instance). 

 

For more details on current files, refer to the Processing Current Files section. 

Pages Components 

The objective of this section is to present the main components you can find in a page and the way 

to use them.  

Tabs 

Tabs are used to better organized and divide the information in pages and provide a better file 

management. 

Currently 

active tab

File currently selected 

highlighted in white

File number

Borrower 

name
Tabs Save and Cancel buttons used 

when editing the page

Information sections for 

the file that is selected

File status zone

Vertical scroll bar to move up and 

down the information in the page
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To select a tab and display the corresponding information, just click the name of the tab. The 

selected tab is displayed in front plan and in a different color (white) and the information included in 

this tab is displayed. 

Tabs that are not selected are displayed in a gray color and in background. When the mouse is over 

a tab, the tab title is underlined. 

 

Editable Fields 

Every page includes editable fields (information zones or input zone) that you can modify and non 

editable fields that you cannot modify. They distinguish themselves clearly one of the others. 

 Editable field: This input field has a blue background and the cursor flashes inside when you 

click in the field.  

 Non editable field: Has non colored background (white) and no border or text appear grayed out 

in the field. No input box and if click in the field, nothing happens.    

 

 Field being modified: When you edit a field, it is displayed with a blue border around the input 

box and the text is also displayed in a blue bold color. It is then easy for you to distinguish the 

fields that have been modified thanks to their specific color. These modified fields come back to 

their standard black color as soon as the modifications are saved. 

  

Active tab 

(selected) Tab the mouse is over (underlined)

Editable field (blue 

background, blue text, cursor 

flashing inside)

Non editable field (no 

background, cursor 

cannot be placed inside)

Non editable field (text 

appear grayed out in the 

field)

Modified field displayed in blue
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Drop-down Lists 

Drop-down lists are fields with the form of lists offering predefined choices among which you can 

select an element. 

 

Click the arrow on the right of the field to expand the list and display the different choices then click 

an element in the list to select it and defined it as the value for the field. 

 

Option Buttons 

Option buttons are fields used to propose mutually exclusive choices. 

As soon as you click an option button, it is selected and marked in color and the previously selected 

button is automatically unselected. 

 

Check Boxes 

Check boxes are available when it is possible to make multiple selections or to indicate that an action 

is completed. 

Click to check or uncheck a box. 

Example of a drop-down 

list for the Province field

Click to expand or reduce 

the list

Click to select an 

element in the list

Element that is selected in 

the list

Click an option to select it 

exclusively
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Calendar 

The calendar is used to complete fields requiring dates. 

Click the icon on the right of a date field to open the calendar. 

 

The calendar provides many options that are described as following: 

 

Memo Fields 

Memo fields are text field with multiple lines; they are often used for entering notes. They have the 

same behavior as text fields except the vertical scroll bar available on the right side and used to scroll 

vertically the text in the box. 

Check boxes

Click the link or the box 

to check it

Click to open the 

calendar

Date the mouse is over 

– click to select it

Date currently 

selected

Click to close the 

calendarClick to select 

today date

Currently selected month 

and year

Click to go to the next year. Keep holding 

the mouse to display a list of years and 

select one

Click to go to the next month. Keep 

holding the mouse to display a list of 

months and select one

Click to go to the previous year. Keep 

holding the mouse to display a list of 

years and select one

Click to go to the previous month. Keep 

holding the mouse to display a list of months 

and select one

Year’s weeks

Click a day to define it 

as the first day of the 

week

Today date
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Expandable Zones 

To maximize the working space, some information is not automatically displayed. This information is 

masked and you have to click to display it. This type of information is included in expandable zones. 

Expandable zones are easily distinguishable because they display an arrow on their left side and a 

black title. Click the arrow or the zone title to display or mask the information. 

The following screen displays an expandable zone that is contracted. The information is not masked: 

 

The following screen displays the same expandable zone but not longer contracted. The information 

is no longer masked and is visible: 

 

Dialog Boxes 

To maximize the working space and not overloading it with too many pages, some information is only 

displayed when requested and is shown in a separate window called "dialog box".  

Dialog boxes are displayed in front of the pages. You have to complete the information included in a 

dialog box then save and close it to return to the pages of a file. If the dialog box contains a field it 

can be modified and saved as in the pages of the file.  

You will find below an example of a dialog box:  

Use the vertical scroll bar to move 

up and down the text

Enter your text

Press the Enter key to add 

a new line

Expandable zone with a black 

arrow on the left side

Click the arrow or the bold 

text to expand the 

information

Expanded zone – the 

information is displayed and 

the arrow is blue and 

downward

Click the arrow or the bold 

text to hide the information
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Examples of dialog boxes in Assyst Real Estate include: 

 Your profile information, the transaction report, notes, etc. 

Functions 

You will find through the application a certain number of links which correspond to functions. They 

allow you to make operations in the application. These links often have different colors and are 

underlined when the mouse is over. 

To activate a link, just click it with the mouse. The mouse always takes the shape of a hand when a 

link is active. 

The following are examples of links in Assyst Real Estate.  

 

Status Window 

When the system's answer delay is not immediate, a status window is displayed asking you to wait 

until the process is completed. When this status window is displayed, you cannot modify any 

information in Assyst Real Estate and all fields and functions are disabled. 
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Using the File Functions 
Functions that are common to all files are: sorting, searching, selecting, printing, etc. 

You will use these functions on a regular basis and you need to be familiar with their functioning. 

Displaying the Financial Institution Files 

Your files are organized in Assyst Real Estate per financial institution - and per lawyer/notary 

responsible in case of file sharing. To maximize your workspace and to display only the adequate 

information, the files pertaining to a specific financial institution are displayed (expanded list with  

sign) or hidden (contracted list with  sign). 

 To display the list of files of a financial institution 

1. Click the  sign to the left of the name of a financial institution to expand the list and display 

all files including in the list for this financial institution. 

2. Click the  sign to the left of the name of a financial institution to contract the list and hide 

the files attached to this financial institution. 

 

Sorting Files 

New files are displayed from the oldest non accepted file to the most recently received file. This 

sorting cannot be modified. 

Current files are sorted by file number (increasing or decreasing) or by borrower name (alphabetical 

order). You can modify this sorting. 

 To sort files 

1. Click in the title bar of the list of files either the Borrower title or the file number (No). An  

arrow sign is displayed on the right of the sort criteria and indicates the sort type (ascending 

or descending). Click again to change the file sorting.    

The direction of the arrow sign ( )indicates if the sort is ascending (up) or descending 

(down) 

Click to hide the list 

of files

List of files

Click to expand the 

list of files
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Refreshing/Updating Files 

You can ask at any time to the system to refresh your files and get the latest available data for each 

file, including notes or new files that have been assigned to you. 

 To refresh files 

1. Click the Refresh Files link on top of your list of files. 

 

The list of your files is refreshed and displayed again, with new data if applicable. New notes 

are added to your files and a  symbol is displayed to indicate that they are not yet read. If 

new files have been assigned to you, they are added to your list of new files 

Displaying/Hiding Files 

To maximize your workspace, you can completely hide the list of your files on the left pane. When 

files are hidden, only the information pages are displayed full screen. 

 To display or hide files 

1. Click the Hide Files link on top of your list of files to hide your files. 

Click to modify the 

sort order

List sorted by file 

number
List sorted by 

borrower name
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The list of your files on the left pane is hidden. Only the information page related to the 

currently selected file is displayed. 

2. Click the Show Files link on top of your list of files to display again your files. 

 

The left pane is displayed again with the list of your files. 

Selecting Files 

When you want to consult a file and see the related information, you have to select the file in the list 

of your files. 

 To select a file 

1. Select and click the name of the file you want on consult in the list of your files on the left 

pane. 

If it is a new file that you select, it is displayed in a light green color in the list of new files. 

 

If it is a current file that you select, it is highlighted in white in the list of current files. 

 

 

As soon as you select a file, its detail is displayed within pages on the right pane. 

New file displayed in a light 

green color when selected

Current file displayed in 

white when selected
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 Note: When you move the mouse over the files in the list of files, the mouse becomes a hand 

to indicate that you can click to select something. 

Searching for Files 

Assyst Real Estate integrates a search function to allow you to search files according to specific 

criteria. 

 Note: The search function allows you to search for closed files that are no longer displayed in 

your list of files. These closed files can be searched if they are closed for less than 6 months. 

 To search for a file 

Click the Search for Files link on top of the list of files. 

 

This will display the Search for Files dialog box. 

New file currently 

selected

Information page for the file 

that is selected
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2. Complete your search criteria. You can combine more than one criterion. 

The different criteria that are available are the following. 

Field Description 

File No Enter the number of the TELUS file you are looking for 

Internal File No. Enter the internal file number of the document you are looking for 

Financial Institution Choose among the available choices the one that you are looking for. 

Transit No Text field. Enter the transit number of the file you are looking for. 

Loan No Text field. Enter the loan number of the file you are looking for. 

Name of one of the 

Borrower 

Text field. Enter the name of the borrowers of the file you are looking 

for 

Property Address Text field. Enter the property address of the file you are looking for. 

 

Example: To look for "123, Wood Street", type "123, Wood Street ". If 

you just type "123", the system will look for all the files having an 

address beginning with 123 no matter the name of the street can be. 

Date File Received Date field. Use the calendar to select the date for the file(s) you are 

looking for. 

File Status Drop-down list. Select among the choices the file status you are 

looking for. 

Legal Counsel Drop-down list (for legal assistants only). Select the name of the legal 

counsel you are working for. The search will only apply to the files of 

this specific legal counsel. 
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3. Click the Search button. 

The system runs the search according to your criteria. The information related to the first file 

answering your criteria is automatically shown. Other found files are displayed in the list of 

files, sorted out by file number. 

If the system does not find any file answering your criteria, a message is displayed to inform 

you about it. 

 

4. Select in the list of files resulting from the search the file you want to consult. 

5. Click the Refresh Files link on top of the list of files to cancel your search and display again 

all the files. 

 You can click the Cancel button at any time if you want to cancel the search and close the 

Search for Files dialog box. 

Printing Files 

You can print at any time the information related to a file. You just need to display this information and 

select the printing function. 

 To print a file 

1. Select a file in your list of files. 

2. Select a tab to display the information you want to print. 

3. Make sure that all the information you want to print is displayed.  

4. Expandable lists and hidden information are not printed if you do not display them. 

5. Click the Print link on the top right side of the page.  

 

This will display the Windows Print dialog box. 
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6. Choose your printing parameters then click the Print button. This will start the printing 

process. 

 Only the information displayed in the different tabs of the pages can be printed. The list of files 

cannot be printed.  

 Only the information currently displayed in a tab can be printed. If you want to print the 

information from different tabs, you must display and print one tab after the other. 

 The information included in dialog boxes cannot be printed. 

Modifying the File Information 
When handling your files, you have to modify the existing data or add new data. You edit or complete 

the editable fields in the file pages or in the different dialog boxes available in Assyst Real Estate. 

The objective of this section is to show you how to edit your file and modify the data then save them. 

Modifying the Data 

To enter or modify data in your files, you use the editable fields displayed in every page. Depending 

on the field type, you enter or modify a value or select one from a list, etc. 

 To modify data in a page 

1. Select a file in your list of files. 

2. Select a tab to display the information you want to modify or complete. This will display one 

of the Assyst Real Estate page. 

3. Find the field you want to complete or update. 

4. Depending on the field type (date, text, drop-down list, etc.), enter or select a value. 

5. Repeat steps 3 to 4 for every field you want to modify.  

6. Modified fields are displayed in a different color (blue text and border) as long as they are not 

saved. You can then see at a glance all the modified fields. The color is changed back to the 

regular color as soon as the changes are saved. 

 

Invalid Data 

If you enter an invalid value in a field, the field is displayed in red. 

Modified field displayed in blue
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For instance, as displayed in the following example, the postal code that has been entered is in an 

invalid format, not recognized by the system as being a standard Canadian postal code. 

 

 As long as the value in a field is invalid (and red), the information cannot be saved. A message 

is prompted if you want to save and you have to correct the invalid value prior to save. 

 

Saving Modifications 

Saving in Pages 

When you modify or update the content of a page, the fields that have been modified are displayed in 

a different color (blue) and the two buttons Save and Cancel on the top right side are enabled. 

 

As any Web application, the modifications in the Assyst Real Estate pages are not automatically 

saved. You are responsible for asking the system to save your data.  

 To save data in a page 

1. Select a file in your list of files. 

2. Select a tab to display the information you want to modify or complete. This will display one 

of the Assyst Real Estate page. 

3. Modify the content of the page by entering or updating some field values. Modifications are 

displayed in blue. 

4. Click the Save button on the top right side of the page.  

A temporary status window may be displayed. 
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When the saving process is completed, fields that have been modified are displayed again in 

their regular color. 

 If you attempt to select another file or another tab while being in a page where you did 

modifications without saving, a warning message is displayed and you have to save or cancel 

your modifications to move to another page. 

 

 If a field value is invalid (red color), the page cannot be saved. You have to correct the invalid 

value prior to leave. 

. 

Saving in Dialog Boxes 

You can save in a page or in a dialog box. The behavior is similar in both environments. You have to 

save your data before closing any dialog box or you will lose your modifications. 

 To save data in a dialog box 

1. Open a dialog box. 

2. Apply your modifications to the fields in the dialog box. Modified fields are displayed in blue. 

3. Click the Save button on the top right side of the dialog box. 

When the saving process is completed, the dialog box is closed. 

 If you forget to save and you close the dialog box with the  button, your modifications will 

be lost. 

 If a field value is invalid (red color), the dialog box content cannot be saved. You have to 

correct the invalid value prior to close the dialog box. 
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Canceling Modifications 

Canceling in Pages 

You can decide at any time to cancel your modifications to the fields in a page. The original field 

values prior to your changes are then displayed again. 

 

 To cancel modifications in a page  

1. Select a file in your list of files. 

2. Select a tab to display the information you want to modify or complete. This will display one 

of the Assyst Real Estate page. 

3. Modify the content of the page by entering or updating some field values. Modifications are 

displayed in blue. 

4. Click the Cancel button on the top right side of the page. 

 All modifications applied to all fields since the last saving operations are cancelled and the 

previous values are displayed again. 

Canceling in Dialog Boxes 

You can cancel in a dialog box the same way to do it in a page. The behavior is similar in both 

environments. 

 To cancel modifications in a dialog box 

1. Open a dialog box. 

2. Apply your modifications to the fields in the dialog box. Modified fields are displayed in blue. 

3. Click the Cancel button on the top right side of the dialog box. 

When the canceling process is completed, the dialog box is closed and all modifications are 

cancelled. 
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Consulting the Messages from TELUS 
Assyst Real Estate provides an internal message system that allows you to automatically receive 

messages sent by TELUS. This can be helpful to inform you of major changes in the system or of 

temporary technical issues or updates, etc. The TELUS messages can be dedicated to one user 

precisely or to all users in the system.  

New messages are automatically displayed when you start a new working session. Once read, they 

are archived and kept in the system for a given period of time (this period depending on the subject 

of the message). After this delay, they are deleted by TELUS in the system. 

You can consult at any time the archived messages available in your bank of messages. 

Automatic Reception 

In Assyst Real Estate, the message reception is automatic. When you start a new session, a window 

called Messages is immediately opened and displays the list of new messages. When you close this 

window by clicking the Close button, the messages inside the window are considered as read and 

are automatically archived in your bank of messages until their definitive removal from the system by 

TELUS. 

Consulting the Archived Messages 

You can consult at any time the archived messages available in your bank of messages. 

 To consult the archived messages 

1. Click the Messages button available in the top toolbar.  

 

This will display the Messages window. 
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The window displays the list of messages sent recently by TELUS and still archived. Use the vertical 

scroll bar on the left side of your window to move up and down in the content of the window. 

The following information is available for every message:  

Field Description 

Subject Subject of the message 

From Name of the sender of the message 

Reception Date Date the message was received 

2. Click the Close button to close the Messages window. 

Selecting the Language 
Assyst Real Estate is available in two languages: English and French. You can decide at any time to 

change the working language when being in the application. 

 Note: The default language displayed when you login to Assyst Real Estate corresponds to 

the language defined in your profile. Refer to the Completing Your Coordinates and Address 

section for more details on My Profile page. 

 To select the working language within the application 

1. Click the Français link on the top right corner of the Assyst Real Estate main window. This 

will switch the whole application language into French. 
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2. Click the English link on the top right corner of the French Assyst Real Estate main window 

to go back to the English version. 

 

Getting Help 
The help is available to allow you to answer your questions as for the use of Assyst Real Estate and 

to provide support in case of problem. It is also a tool to allow you to learn how to use Assyst Real 

Estate. 

 To open the help 

1. Click the Help link on the top right corner of the Assyst Real Estate main window to open 

the Help main page. 

 

Closing a Session 
When you want to end your working session with Assyst Real Estate, you have to logout the 

application. 

 To close a session 

1. Click the Logout link on the top right corner of the Assyst Real Estate main window to end 

your working session. 
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This will close the Assyst Real Estate window. 

 If you try to logout Assyst Real Estate without having previously saved the latest data you 

have modified, a message will prompt and you will have to save or cancel your modifications 

prior to logging out. 

 Note: the Logout hyperlink is not available for BC online users. 
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SECTION 2 

MANAGING THE SYSTEM 
 

Chapter 4 - Managing Your Profile 

Chapter 5 - Working With Transaction Reports 
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Chapter 4 
Managing Your Profile 

The objective of this chapter is to present the information about your profile that is available in Assyst 

Real Estate and how you can access and modify this information. Your profile is different depending 

on who you are: a lawyer/notary or a legal assistant. 

You have to complete the information on your profile the first time you start using Assyst Real 

Estate. Profiles remain the same from one file to another; there is no need to verify it each working 

session. 

About Your Profile 
Your profile is different depending on who you are: a lawyer/notary or a legal assistant. In Assyst Real 

Estate, the information contained in your profile includes: 

 Your coordinates,  

 Your address,  

 Your password,  

 Your out of office notification (for lawyers/notaries only),  

 Your alerts (for lawyers/notaries only) 

 Your payment information (to TELUS), (for lawyers/notaries only) 

 Your funding information (for lawyers/notaries only) 

 Your file sharing information (for lawyers/notaries only) 

 The legal counsels you work for (for legal assistants only) 

You have to complete the information relative to your profile the first time you start using Assyst Real 

Estate. You can modify it without restriction at any time. 

The information about your profile is used in the files you have to handle and in the case of your 

payment transactions to TELUS (for lawyers/notaries only); it is important to keep it up to date. 

Opening Your Profile 
The objective of this section is to explain where you can access your profile. It also introduces the 

different information available in your profile. 
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 To open your profile 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page. 

 

This will display the My Profile window. You will find in this window all the information relative 

to your profile. You can modify every field in this window. 

The My Profile window is organized into the following pages (tabs): 

 General Information: Includes the information relative to your coordinates, your address, your 

password, your Out of office notification, and your alerts.  

 Payment (for lawyers/notaries only): Includes the information relative to your credit card that is 

required when paying your transactions to TELUS.  

 Funding Info (for lawyers/notaries only): Includes the information relative to your funding method.  

 File sharing (for lawyers/notaries only): Includes the list of legal assistants and legal counsels with 

who you share your files and their access rights. 

 Legal counsels (for legal assistants only): Includes the list of legal counsels you work for.  

Completing the General Information 
This section presents the information relative to your coordinates and address available in the General 

Information tab of the My Profile page. 

Completing Your Coordinates and Address 

Your coordinates are available in the General Information page in the My Profile page. 

 To complete your coordinates and your address 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Make sure the General Information tab is selected. 

3. Complete or modify the fields in the Coordinates and Address sections. 
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The table below provides you with the list of all fields included in the Coordinates and Address 

sections. You can edit every field. 

Field Description 

Last Name Text field. Enter your last name. 

First Name Text field. Enter your first name 

Firm Name Text field. Enter your firm name 

Language Drop-down list. Select your working language. The Assyst Real 

Estate interface will be always displayed by default in this 

language. 

Title Drop-down list. Select your title 

Personal E-mail Enter your personal e-mail address. Make sure to respect 

standard e-mail address formats. This e-mail address is important 

and is used by TELUS to send you your passwords and other 

messages linked to your files 

Office E-mail Enter your office e-mail address. Make sure to respect standard e-

mail address formats. 

Office Phone Numeric field. Enter your office phone number. 
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Fax Numeric field. Enter your fax number 

Civic Number / Street Enter your street name and civic number. 

Apartment / Suite Enter your apartment or suite number 

P.O Box Enter your P.O box number. 

City Enter the name of your city 

Province Drop-down list. Select your province. 

Country Drop-down list. Select your country. 

Postal Code  Enter your postal code. Make sure to respect the postal code 

format used in Canada or in the United States 

4. Click the Save button to save your modifications. This will close the My Profile window. 

 When the data entered in a field are invalid, this field is displayed in red. You cannot save your 

data in this case as long as you do not correct the invalid values. 

Modifying Your Password 

You can change your password at any time in the General Information tab in My profile window. 

Your password must have between 6 and 8 characters including two digits. 

 For security reasons, it is recommended to change your password on a regular basis. The 

system will automatically ask you to change it after 60 days because your password will 

automatically expire after this limited period of 60 days. 

 To modify your password 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Make sure the General Information tab is selected. 

3. In the Password section, complete the following fields: 
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Field Description 

Current Password Enter your current password. Make sure to respect capital and 

small letters. 

New Password Enter your new password. Your password must have between 6 

and 8 characters including two digits 

Confirm New Password Reenter your new password. Make sure to respect the same 

capital and small letters than in the previous field. 

 

If you enter incorrect data or erroneous passwords, messages will prompt and you will not be able to 

save your edits or close the window. 

 

 

4. Click the Save button to save your modifications. This will close the My Profile window. 

Your new password will be valid the next time you will log into Assyst Real Estate. 

Enabling/Disabling Your Out of Office Notification 

(Lawyers/Notaries only) 

The Out of Office Notification is a very useful option, dedicated to lawyers and notaries, allowing you 

to inform the financial institutions which assign you new files that you are away for a given period of 

time. If you enable this option, by indicating a departure and return date, the system will automatically 

send a notification to any financial institution which will assign you a new file during your absence. 
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Enabling Your Out of Office Notification 

To define an out of office notification, you have to indicate a departure and return date. During this 

period, the financial institutions which will assign you new files will be informed about your out of 

office notification. You can define an out of office notification for a maximum period of 3 months. 

 To enable your Out of Office Notification 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Make sure the General Information tab is selected. 

3. In the Out of Office Notification section, complete the two Departure Date and Return 

Date fields using the calendar tool: 

 

Field Description 

Departure Date You can use the calendar to enter your departure date. The date 

format is Year/Month/Day. 

Return Date You can use the calendar to enter your return date. The date 

format is Year/Month/Day. Your return date cannot exceed by 

more than 3 months your departure date. Your return date cannot 

be before your departure date. 

 

Both Departure Date and Return Date fields must be completed for the out of office notification to 

be enabled. 

 Note: For more details on how to use the calendar, refer to the Calendar section. 

4. Click the Save button to save your modifications.  

A message will inform you that your Out of Office Notification is enabled. 
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5. Click the OK button. This will close the My Profile window. 

The next time you will login to Assyst Real Estate, a message will inform you that your Out 

of Office Notification is enabled and will ask you if you wish to disable it. In this case, click 

NO then Continue to keep it enabled or click Yes and Continue to disable it. 

 

Disabling Manually Your Out of Office Notification 

You can disable manually your Out of Office Notification at any time. There are two ways of doing it. 

 To disable manually your Out of Office Notification 

Method 1: 

1. Login to Assyst Real Estate. A message will inform you that your Out of Office Notification 

is enabled and will ask you if you wish to disable it. 

2. Click the YES answer to disable your Out of Office Notification. 

 

3. Click the Continue button to close the window. 

Click YES to 

disable the out 

of office 

notification

Click to confirm 

your answer and 

close th window
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Your Out of Office Notification is disabled. 

Method 2: 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Make sure the General Information tab is selected. 

3. In the Out of Office Notification section, click the Disable button. 

 

Both fields Departure Date and Return Date are emptied. Your Out of Office Notification is 

disabled. 

Automatic Disabling of the Out of Office Notification 

Your Out of Office Notification is automatically disabled when your return date is reached. 

Setting Alerts (Lawyers/Notaries only) 

You can set your profile in Assyst Real Estate to be informed via e-mail every time: 

 New notes are added to your files 

 New files are transmitted to you 

The alerts function in the My Profile page allows you to set these alerts. You can define if you want to 

receive your alerts at your office or personal e-mail address. 

 To set alerts 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Make sure the General Information tab is selected. 

3. In the Alerts section, select in the drop-down list to which e-mail address the alerts will be 

sent: Personal e-mail or Office e-mail. 

4. Select None if you do not want to receive any e-mail alerts. 

5. Check the Notes box to receive e-mails when new notes are added to your files. 

Click to disable your 

out of office 

notification
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Or 

Check the Files box to receive e-mails when new files are transmitted to you. 

6. Click the Save button to save your modifications and close the My Profile window. 

 

Modifying Your Payment 

Information (Lawyers/Notaries only) 
The information relative to your payments (for lawyers and notaries) is available in the Payment tab in 

the My Profile window.  

The payment information is used when you are invoiced and when you pay the charges to TELUS (for 

lawyers and notaries) when accepting new files and using the online registration service for your 

documents. 

If you complete your payment information in your profile, this information is automatically used in your 

transactions and you do not have to enter them again. If you do not complete your payment 

information in your profile, the system will ask you to enter it every time this will required during your 

transactions with TELUS. 

The only one payment mode that is accepted in Assyst Real Estate is the credit card (Visa, Master 

Card or American Express).  

 To modify your payment information 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Click the Payment tab. 

Select the type of alerts you 

want to receive

Select the e-mail address to 

be used for sending the alerts
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3. Complete the following fields in the Payment tab: 

Field Description 

Credit Card Type Drop-down list. Select your credit card type. You have 3 choices: 

Visa, MasterCard or American Express 

Credit Card Number Numeric field. Enter your credit card number. 

Cardholder Name Text field. Enter the cardholder name as displayed on your credit 

card. 

Expiry Date Numeric field. Enter your credit card's expiry date using the 

following format: Month/Year 

4. Click the Save button to save your modifications. This will close the My Profile window. Your 

payment information is saved and will be automatically reused for every transaction. 

 Note: For security reasons and to protect your credit card information, only the last 4 figures 

of your credit card are shown in the screen, the other numbers are replaced by X. 



 

 73 

Modifying Your Funding Information 

(Lawyers/Notaries only)  

The objective of this section is to show you how to complete and to modify your funding information 

(for lawyers and notaries only) available in the Funding Info tab in the My Profile window. 

The funding information is used when transferring funds to your trust account (for lawyers and 

notaries). These data are merged when the system generates the preliminary reports for your files. If 

you complete your funding information in your profile, this information is automatically used when 

creating the preliminary reports and you do not have to enter them again.  

Note: If you do not complete your funding information in your profile, the system will ask you to enter 

it every time this will be required when creating preliminary reports. 

 Assyst Real Estate offers two disbursement modes: direct deposit or cheque/bank draft.  

 To complete or modify your funding information 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Click the Funding tab. 

 

 

3. Complete or modify the following fields in the Funding tab: 
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Field Description 

Financial Institution  Drop-down list. Select a financial institution.  

 

Transit No Text field. Enter the financial institution's transit number. 

 

Transit Name Display the Transit Name of the Caisse. 

Note:  This field is displayed only when the Financial Institution 

selected is Caisse  and when a transit number is entered in the 

field Transit No 

Trust Account Text field. Enter your trust account number. 

 

Favorite Text box. select the account you normally use 

Note:  only one account can be selected 

4. Click the Save button to save your modifications. This will close the My Profile window. 

The information is saved. These data are merged when the system generates the 

Preliminary Reports for your files.  

Adding Direct Deposit Accounts   

Click the Add button link to add a Direct Deposit Account in the Funding Info window.  

Click the Remove link to delete a Direct Deposit Account. 

 You can add up to 10 Direct Deposit Account. 
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Selecting the Financial Institution and the Funding 

Information 

When you generate the Preliminary Report in the Document section, the dialog box Generate a 

Document is displayed allows you to select the Direct deposit account that will be used when 

transferring funds. This information will also be generated in the Preliminary Report. If you have not 

previously entered any information regarding a Financial Institution in the Funding Info section, only 

the Cheque / Bank Draft option is selected. 

By default, the Financial Institution you have previously entered in the Funding Info section is 

selected. If you enter more than one Financial Institution and if the Favorite box was not checked for 

any of them the option button will be selected before the first financial institution displayed in the list. 

You can modify your choice by selecting another Financial Institution.  

Note: If the option Cheque / Bank Draft is selected, not any Financial Institution will be selected and 

no information regarding them will be merged in the Preliminary Report. 
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Sharing Your Files (Lawyers/Notaries only) 

As a lawyer/notary, you can share your files in Assyst Real Estate with people in your staff (your legal 

assistants) or even with other lawyers/notaries. The File Sharing tab in My Profile page is designed 

to help you managing the list of people with who you are sharing your files and their access rights. 

When sharing your files, you can grant different access rights to the people who will work with you on 

your files. The 3 different permissions are: 

 Access files: This permission allows the person with who you are going to share your files to 

access all your files and modify them.  

 Accept files: This permission allows the person with who you are going to share your files to 

accept or refuse a new file. 

 Update profiles (for legal assistants only): This permission allows the legal assistant with who you 

are going to share your files to update your own profile. 

Depending on the mix of permissions, the legal assistants or lawyers/notaries with who you are 

sharing your files will only see your new files (accept files permission only), or will see all your files 

(access files permission). 

When you grant access to your files to a legal assistant or to another legal counsel, he is informed via 

e-mail that you have given him access to your files. 

 A maximum of 50 legal assistants or legal counsels can be associated to your profile. 

Sharing Files with Legal Assistants 

You manage the legal assistants with who you share your files and their access right in the Legal 

Assistants section of the File Sharing page. 
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This section displays the names of the legal assistants who have requested a file sharing with you or 

who are already sharing files with you. It is up to you to define their access to your files. 

 To grant access rights to a legal assistant 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Click the File Sharing tab. 

The list of legal assistants who share your files or who have requested to share your files is 

displayed. 

 

3. Check the different boxes depending on the rights you want to grant to a specific legal 

assistant. 

 Check Access Files to grant access to all your files and to the right to modify them. 

 Check Accept Files to grant access to accept (or refuse) a new file in your name. 

 Check Update Profile to grant access to your profile and to modify it. 

4. Click Save to confirm your changes. 

A dialog box File Sharing Change Summary is displayed to let you confirm your changes. 

 

5.  Click Accept to confirm your changes. 

The dialog box is closed and the new access right in displayed in the File Sharing tab of My 

Profile page. 
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A mail is automatically sent to the legal assistant informing him that you have granted him 

access to your files. 

 A maximum of 50 legal assistants can be associated to your profile. 

Sharing Files with Legal Counsels 

You manage the other legal counsels with who you share your files and their access right in the Legal 

Counsels section of the File Sharing page. 

This section displays the names of the legal counsels with who you are already sharing files with you. 

It is up to you to define their access to your files. 

 To grant access rights to a legal counsel 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Click the Legal Counsels tab. 

The list of legal counsels who share your files is displayed. 

 

3. Click the Add link to add a new legal counsel. The Legal Counsel Search dialog box is 

displayed. 

 

Complete the criteria for your 

search. You must select a 

province and enter the first 2 

letters of the name of the legal 

counsel you are looking for

Click to perform the search

Results of the search

Click to select the name of 

the legal counsel
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4. Complete the criteria for your search by selecting the Province and the City (if desired) and 

by entering the first 2 letters of the Name of the legal counsel you are looking for. 

5. Click the Search button to perform the search.  

 A message is displayed if no record matches your criteria. 

 If the name of the lawyer/notary you are looking for is not listed, please contact the Assyst 

Real Estate Service Desk. 

The results of the search are displayed in a list.  

6. Select the name of the legal counsel you are looking for.  

7. Use the scroll bar to move up and down in the list.  

The Legal Counsel Search dialog box is closed and the name you selected is automatically 

added to the list of legal counsels in the Legal Counsels section of My Profile page. 

 

8. Check the different boxes depending on the rights you want to grant to the legal counsel. 

 Check Access Files to grant access to all your files and to the right to modify them. 

 Check Accept Files to grant access to accept (or refuse) a new file in your name. 

9. Click Save to confirm your changes. 

A dialog box File Sharing Change Summary is displayed to let you confirm your changes. 

 

10. Click Accept to confirm your changes. 



Reference Guide  Assyst Real Estate 

 

80 

The dialog box is closed and the new access right in displayed in the File Sharing tab of My 

Profile page. 

A mail is automatically sent to the legal counsel informing him that you have granted him 

access to your files. 

 A maximum of 50 legal counsels can be associated to your profile. 

Removing a Legal Assistant or Legal Counsel from 

Sharing Files 

You can at any time remove a legal assistant or legal counsel from the list of people who share your 

files. This people will not see anymore your files when logged into Assyst Real Estate. 

 To remove a legal assistant or a legal counsel  

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Click the File Sharing tab. 

The list of legal assistants and legal counsels who share your files is displayed. 

3. In the Legal Assistants list or in the Legal Counsels list, check the Remove button to 

indicate that you want to remove this user from the list of people who share your files. 

 

A warning message displayed. 

 

4. Click OK to confirm you want to remove this user. 

5. Click Save in the My Profile page to confirm your changes. 

Check to remove the legal 

assistant from the list
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The name of the legal assistant or legal counsel is removed from the list of the people who 

share your files. 

Adding/Removing Legal Counsels 

(Legal Assistants only) 
As a legal assistant, you manage in your profile the list of legal counsels you work for. The Legal 

Counsels tab in My Profile page is designed to help you to add or remove legal counsels and 

consult their general information.  

When you add a legal counsel in you profile, the lawyer/notary is informed via e-mail that you have 

requested to share his files. He can then in his profile grant you the appropriate rights to share files, 

accept or refuse files, update his profile, etc, in his name. You can then see the list of his files under 

his name in your list of files in the main page. 

 Note: A maximum of 50 legal counsels can be associated in your profile. 

 To add a legal counsel 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Click the Legal Counsels tab. 

The list of legal counsels you already work for and with who you share files is displayed. 

 

3.  Click the Add link to add a new legal counsel. The Legal Counsel Search dialog box is 

displayed. 

List of legal counsels you 

share files with

Check to remove a legal 

counsel from the list

Click to add a legal 

counsel to the list
Click the name of a legal counsel 

to display the information for this 

lawyer/notary

Click Save when finished
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4. Complete the criteria for your search by selecting the Province and the City (if desired) and 

by entering the first 2 letters of the Name of the legal counsel you are looking for. 

5. Click the Search button to perform the search.  

A message is displayed if no record matches your criteria. 

 If the name of the lawyer/notary you are looking for is not listed, please contact the Assyst 

Real Estate Service Desk. 

The results of the search are displayed in a list.  

6. Select the name of the legal counsel you are looking for.  

7. Use the scroll bar to move up and down in the list.  

8. The Legal Counsel Search dialog box is closed and the name you selected is automatically 

added to the list of legal counsels in the My Profile page. 

 

 You can click the name of any legal counsel in your list to display the general information 

associated with this lawyer/notary. 

9. Click Save to confirm your changes and save the list. 

Complete the criteria for your 

search. You must select a 

province and enter the first 2 

letters of the name of the legal 

counsel you are looking for

Click to perform the search

Results of the search

Click to select the name of 

the legal counsel
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A mail is automatically sent to the lawyer/notary you have added to your list of legal counsels 

specifying that you have requested to share his files. He will then have to grant you the appropriate 

permissions in his profile. 

Once a lawyer/notary has granted you the rights to share his files, you can see the list of the files he is 

responsible for under his name in the list of your files in the Assyst Real Estate main page. 

 To remove a legal counsel 

1. Click the My Profile button in the top left section of the Assyst Real Estate main page.  

This will display the My Profile window.  

2. Click the Legal Counsels tab. 

The list of legal counsels you already work for and with who you share files is displayed. 

3. Check the Remove button to indicate that you want to remove this lawyer/notary from the 

list of legal counsel you share files with. 

 

A warning message displayed. 

 

4. Click OK to confirm you want to remove this legal counsel. 

5. Click Save in the My Profile page to confirm your changes. 

The name of the legal counsel is removed from the list. 

 

  

Check to remove a legal 

counsel from the list
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Chapter 5 
Working with Transaction Reports 

A transaction report allows you to view the list of your invoicing and/or credit operations with TELUS 

over a given period. The objective of this chapter is to show you how to generate a transaction 

report, to print it and save it. 

Note:  Legal assistants can generate reports for the lawyers/notaries they work for. 

About Transaction Reports 
In Assyst Real Estate, the transaction report provides you with the list of your transactions (invoices 

and/or credits) with TELUS over a given period where you have used Assyst Real Estate and its 

services.  

TELUS charges you and produces invoices in the following situations: 

 When you accept a new file. You see the Acceptance description in the list of your transactions. 

 When you register online a document. You see the Registration description in the list of your 

transactions. 

 When you request a Certified Payout Statement to prepare a discharge file. You see the 

Discharge description in the list of your transactions. 

TELUS credits you when: 

 You transfer a file to another lawyer/notary. You see the Acceptation description in the list of 

your transactions but the amount is negative meaning a credit. 

 You cancel a file after having accepted it. You must contact in this case the Assyst Real Estate 

Service Desk. 

All the transactions (payment or credit) are done via a credit card. You can provide the information 

relative to your credit card in your profile (for lawyers/notaries only) or enter it every time you do a 

transaction with TELUS. 

A transaction report cannot exceed a period of more than 31 days. A report cannot be generated for 

a date beyond 90 days of the current date. 

 Legal assistants can generate reports for the lawyers/notaries they work for. 
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Creating a Transaction Report 
You can generate a transaction report at any time. The report is immediately produced and displayed 

in HTML format in a Web page in your Internet browser. 

Legal assistants can generate reports for the lawyers/notaries they work for. 

 To create a transaction report 

1. Click the Transaction Report button in the top left section of the Assyst Real Estate main 

page. 

 

This will display the Transaction Report window. 

 

2. Enter a start date in the Start Date field.  

The date format is Year/Month/Day.  

Use the calendar tool on the right of the field to select a date. 

 You cannot select a start date that is more than 90 days before the current date. A message 

is prompted if you do it.  

3. Enter an end date in the End Date field.  

The date format is Year/Month/Day.  

Use the calendar tool on the right of the field to select a date. 

Click to create the report using 

the selecting dates

Enter the report 

start date

Use the calendar to select a date

Enter the report 

end date

Select the name of the 

legal counsel for who the 

report will be generated 

(for legal assistants only)
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 You cannot select an end date that is before the start date. You cannot select an end date 

that is more than 31 days after the start date. A message is prompted if you do it. 

 For more details on how to use the calendar, refer to the Calendar section. 

4. For legal assistants only: select in the Report Generated for Legal Counsel list the name of 

the lawyer/notary you work for and for who you are generating the report. 

 The Report Generated for Legal Counsel field is only displayed for legal assistants. 

5. Click the Create button to generate the transaction report according to the dates. 

 You can cancel the creation of the transaction report at any time by clicking the Cancel 

button in the Transaction Report window. 

The transaction report you asked for a given period is generated and displayed in a Web page. 

Description of a Transaction Report 

The following is an example of a transaction report:   

  

You can find the following information in the transaction report: 

Field Description 

Date Date when the report was generated 

Period Period set for the report (maximum of 31 days). 

Legal Counsel Name Name of the lawyer/notary for who the report is generated. 
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Total Number of 

Transactions  

Total number of transactions listed in the report for the given period.  

 

Field Description 

Date Date when the transaction occurred 

Description Transaction type: Acceptance when accepting a new file or 

Registration when registering online a document 

File No. TELUS  file number 

Internal File No. TELUS internal file number  (entered by the Legal Counsel in the 

Internal File No. on the File page) 

Transaction No. Transaction number    

Main Borrower Name of the main borrower for the file 

Amount Amount of the transaction which is charged (positive value) or 

credited (negative value) 

Printing a Transaction Report 
You can print a copy of your transaction report that is displayed in your Internet browser by using the 

printing function available in your browser. You can keep the printed copy in your archives. 

 To print a transaction report  

1. Generate a transaction report as explained previously.  

The report is then displayed in your Internet Explorer browser. 

2. Click the Print link  in the in the transaction report Web page. 

This will open the Print dialog box.  

3. Select your printing parameters in the dialog box then click the Print button. You transaction 

report is printed. The Print dialog box is closed. The transaction report window is displayed 

again. 
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SECTION 3 

USING THE SYSTEM 
 

Chapter 6 -   Processing New Files 

Chapter 7 -   Discharge 

Chapter 8 -   Processing Current Files 
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Chapter 6 
Processing New Files 

The objective of this chapter is to present the information related to the new files that are sent to you 

by the financial institutions and the steps to be followed to accept to handle these files in Assyst Real 

Estate or to refuse them. 

Every time you accept a new file, an invoice is generated and you have to agree to pay the 

corresponding charges to TELUS.  

Depending on their access rights, legal assistants and other lawyers/notaries can process new files in 

the name of the lawyers/notaries they work with. 

About New Files 

Characteristics 

The new files correspond to the files sent to you (lawyers and notaries) by the financial institutions and 

that you have to accept or refuse to handle. 

New files are the first files displayed on top of your list of files and are displayed in a different green 

color. They are sorted so as the most recent files assigned to you are at the end of the list. This 

sorting order cannot be modified.  

New files are displayed under the name of the lawyer/notary who is responsible for them in case of 

file sharing (for legal assistants for instance). If the Accept files permission has not been granted, 

new files are not displayed. 

For every file the following information is displayed: the TELUS file number, the name of the main 

borrower and the number of hours remaining before the end of the acceptance period. 

 

File that is selected 

displayed in lightest 

green color

List of new files 

(displayed in green)

Emergis file number

Borrower name

Number of remaining 

hours before the end of 

the acceptance period
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Every new file is displayed for a limited period of 2 business days. If at the end of this delay, you have 

not accepted or refused the file, it is sent back to the financial institution which has assigned it to you. 

If your Out of Office Notification is enabled, the financial institution will be informed about your 

absence (for lawyers/notaries only). Refer to the Enabling/ Disabling Your Out of Office Notification 

section for more details on this option. 

When you select a new file in your list of files, the information displayed on the right pane includes:  

 One single tab called New File. 

 The TELUS file number and the name of the main borrower. 

 Various sections with specific information related to the file (general information, borrower, 

properties, etc.) This information cannot be edited as long as the file is not accepted. 

 A dedicated section called Accept or Refuse where you click to accept or refuse the file. 

 

 You cannot handle a new file and view all the related information as long as you do not accept 

it. 

Consulting New Files 
 To consult a new file 

1. In the list of new files on the left pane, click the name of the file you want to consult.  

The file you have selected is displayed in a lightest color than the other files. The information 

related to this new file is displayed on the right pane.  As long as you do not accept a file, 

you cannot modify the file information or add new information. 

2. Use the scroll bars on the right side to move vertically the content of the window and display 

the information that is at the bottom of the page. 

File number

File currently selected 
Unique tab Borrower 

name
File information page

Functions to accept or 

refuse a file
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3. Repeat the steps above to consult another new file. 

 In case of file sharing, if the Accept files permission has not been granted, new files are not 

displayed. 

Accepting New Files 
You have 2 business days to accept a new file when it is displayed in the list of your new files in 

Assyst Real Estate.  

Besides a lawyer/notary, legal assistants and other lawyers/notaries can accept a file in the name of 

the lawyer/notary they work with, if delegated that right. 

Accepting a new file means: 

 Select the Accept option to start the acceptance process. 

 Complete the payment information related to your credit card - if this information is not already 

defined in your profile - to pay the charges linked to the acceptance of the new file. 

 Confirm you agree to pay the charges and be invoiced by TELUS. See Confirming the Payment 

At the end of the acceptance process, the new accepted file is transferred from the list of new files to 

the list of current files under the name of the financial institution which has assigned this new file to 

you (and under the name of the lawyer/notary responsible for it in case of file sharing and if you have 

the right to modify the current files). The new file status is set to "File Accepted" in the Status 

section of the File tab. Time and date the file was accepted are also indicated. 

 

An acceptance notification is automatically sent to the financial institution which assigned it to you to 

inform it of the file status. 

Confirming the Payment 

In the file acceptance process, after accepting the Assyst Real Estate Service Agreement, the next 

step consists in accepting the inherent charges and the corresponding invoice. A new window is 

displayed with the transaction payment confirmation. The invoice includes the file information (TELUS 

file number, name of the main borrower and property address) and the amount to be paid including 

taxes. 
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You (lawyer/notary and assistants and other lawyers/notaries who have been delegated this right) 

have to make sure at this step that the information relative to your payment mode (your credit card) is 

complete and exact. 

 To accept a new file  Payment confirmation step 

1. In the Accept a File window, verify the information about your credit card number and expiry 

date. 

If you update your credit card information at this stage, you can choose to keep this new 

information in your profile by clicking the Update my Profile check box. 

Refer to the Managing Your Profile section for more details on your profile and on your 

payment information. 

 If the data related to your credit card are erroneous, a message will be prompted. Make sure 

to enter the correct information. 

2. Click the Confirm button to confirm that you accept the transaction and the payment. 

 

 

As soon as you confirm the transaction, the window is closed and you move to the next step. 

 Note: For users in British Columbia who are connected to Assyst Real Estate through BC 

online, the Payment section will display their BC Online account number that will be used for 

paying the charges. 

Information on the file 

being accepted and 

invoiced

Invoice amount details

Click to cancel the 

acceptance process
Click to confirm you 

accept the payment

Information on the payment mode

Click to view service 

agreement
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 If an error occurred during the payment process, a message will be prompted and the 

payment will be cancelled. In this case, you will not be able to start working with the file and 

you will have to repeat the acceptance process from the beginning. 

 Any time, if you want to view the Service Agreement for the use of the Real Estate Platform 

you can click View service agreement button. 

 You can click the Cancel button at any time if you want to cancel the process. 

Viewing the Invoice and Accessing the File 

Viewing the invoice and the confirmation of the payment is the last step in the file acceptance 

process. 

In the previous steps, you have accepted the Assyst Real Estate Usage Agreement and confirm the 

payment of the inherent charges. In this last step, you (lawyer/notary and assistants and other 

lawyers/notaries who have been delegated this right) will be able to consult and print the final invoice. 

 To accept a new file  Invoice step 

After accepting the payment, a new window is displayed with the final invoice. The invoice includes 

the following information: TELUS file number, name of the main borrower and property address and 

the amount to be paid including taxes. 

 For users in British Columbia who are connected to Assyst Real Estate through BC online, the 

payment section will display their BC Online account number that will be used for paying the 

charges. 

 A soft copy of the invoice is automatically generated and kept in the list of documents 

available for this new file (see the Documents tab). 

In this final Accept File window, a message is displayed on top to confirm that the payment has been 

processed and to give you a reference number. 
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1. You can print a copy of the invoice by clicking the Print link at the bottom right side of the 

window. This will display the Windows Print window. Click the Print button to start printing. 

2. Click the Open File button to open the new accepted file and consult the information. This 

will close the Accept File window. The new file is displayed. You can now edit it and start 

processing it.  

 In case of file sharing, if the Access files permission has not been granted, the Open File 

option is not available. 

The new accepted file is transferred from the list of new files to the list of your current files under the 

name of the financial institution which has assigned this new file to you (and under the name of the 

lawyer/notary responsible for it in case of file sharing and if you have the right to modify the current 

files).  

The new file status is set to "File Accepted" in the Status section of the File tab. The time and date 

the file was accepted are also indicated. 

" 

Click to close the 

window
Click to open the 

accepted file

Invoice details

Confirmation message and 

reference
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 You can generate at any time the transaction report to view the transaction that has been 

completed. For more details on the transaction reports, refer to the Working with 

Transaction Reports section. 

Consulting the Documents Automatically 

Generated 
Following the file acceptance process, Assyst Real Estate automatically generates different 

documents. These documents are the following: 

 The invoice 

 The TELUS Service Contract 

 The rules and procedures 

 The Notary Instructions or the Notary Mandate or the General Instructions to Lawyer/Notary and 

the Specific Instructions  

All documents associated with a file are available in the Documents tabs. You can select any 

document and open it in Adobe Reader or Microsoft Word (Quebec) to consult the document 

content. 

  In case of file sharing, if the Access files permission has not been granted, the documents 

that have been generated can not be consulted by legal assistants and/or other 

lawyers/notaries. 

 To consult the documents automatically generated  

1. Open the file of which you want to consult the documents that have been automatically 

generated.  

2. Click the Documents tab. This will display the list of documents associated to the file.  

Documents are organized by category. Document categories having a  sign on their left 

side include generated documents. It is the case for: the invoice, the TELUS Service 

Contract, the rules and procedures, the Notary Instructions (for Desjardins) or the Notary 

Mandate or the General Instructions to Lawyer/Notary and the Specific Instructions.  

3. Click the  sign on the left side of a document category to expand the list of generated 

documents for this category. The corresponding file names are displayed (for instance: 

DOC_MANDAT_NOT_(F)_v1.doc). 

4. Select the name of a file document (for instance: DOC_MANDAT_NOT_(F)_v1.doc). This will 

display the information related to this document on the right pane (file name, language, 

creation date and author) 
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5. Double click the name of the file or click the Open link on the right pane.  

  

This will open the file in Adobe Reader or Microsoft Word (Quebec). You can then consult 

and even print it. 

 

 

6. Repeat steps 3 to 5 to open other documents and consult them. 

Information about the selected document (filename, 

version, language, creation date, author)

Set of automatically 

generated documents

Double-click on the name of the file or 

click Open to open the selected document
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Refusing New Files 
If you do not want or if you are unable to handle a new file, you can refuse it and inform by this way 

the financial institution which will reassign it. The new file will be removed from your list of files. 

Besides a lawyer, legal assistants and other lawyers can refuse a file in the name of the lawyer they 

work with, if delegated that right. 

 To refuse a file 

1. Click to select the file you want to refuse in the list of your new files. 

2. Click the Refuse link in the Accept or Refuse section on the right pane. 

 

This will display the Refuse File window. The TELUS file number, name of the main borrower 

and property address are displayed and also a text box that allows you to write the reason 

for the refusal, if desired.   

 

3. The Refuse File window is displayed.   

4. Click the Confirm button to confirm that you refuse the new file. 
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 Click the Cancel button if you want to cancel the process. 

This will display a confirmation message. 

5. Click the Close button to terminate the process and come back to the last opened file. 

The file that has been refused is removed from the list of your new files and a notification is sent to 

the financial institution. 

When a file is refused, the lawyer/notary is not charged any fee. 
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Chapter 7 
Discharge 

The objective of this chapter is to present the different functionality related to Discharge Solution. 

You will learn about different stages of the process and the parallel between the functions of Assyst 

Real Estate and functions used by financial institution. 

We will show you how to add information to a file in order to submit a Request for Payout Statement 

and how to complete the steps and follow the different status. 

You will also learn about the different documents related to the process and presented in the 

Documents section. 

About Discharge 
It will now be possible to send electronically to the Lender, a Payout request and information relating 

to the repayment of the debt, receive an authorization to Discharge and obtain the resolution 

document for the preparation of Discharge. 

The Discharge will also be sent electronically to the Land Register via Assyst Real Estate for 

registration purpose and information about registration will be sent to the Lender. 

Discharge solution 
The diagram below shows you the different stage of management of Discharge and establishes the 

parallel between the functions related to the management of the Discharge solution on Assyst Real 

Estate and those used by financial institutions. 
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(1) Payout Request sent with Assyst Real Estate 

 The Legal Counsel completes the information in Legal Description, Current Registered 

Owner(s) and Interest to be discharged sections on Assyst Real Estate.  

 The Legal Counsel sends the Payout Request to the Lender on Assyst Real Estate.  

 If there is more than one Payout Request for the same file, the Legal counsel can be bundling it 

depending on certain conditions.  

(2) Payout request received by the Lender  

 The Lender received the Payout request. 

 The Lender selects the file and takes note of the information it contains.  

 If no file match to the information received, the Lender clicks the button No File Found. The 

Legal Counsel received a note on this issue in the Note section on Assyst Real Estate. He may 

resubmit a new amended Payout Request for the same file. 

 

(1)  Payout Request sent 

 (2)  Payout Statement Request Received 

(3)  Send Certified Payout Statement 

(4)  Certified Payout Statement received 

(5)  Reimbursement 
(6)  Reimbursement Received 

(7)  Authorize Discharge 

(8)  Authorization to discharge received 

(9)  Discharge registered  (10)  Discharge  Registered 

End of Process 

Assyst Real Estate Financial Institution 
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(3) Certified Payout Statement sent to the Legal Counsel  

 If a file matches the information received, the Lender look at the information it contains and 

completes the Reimbursement Details section. The Lender sends the Certified Payout 

Statement to the Legal Counsel by clicking the Send Certified Payout Statement button.  

 If the Payout Request were bundled, only one Certified Payout Statement will be sent to the 

Legal Counsel. 

 The Certified Payout Statement is send to the Legal Counsel on Assyst Real Estate, in the 

Documents section.  

(4) Certified Payout Statement received on Assyt Real Estate 

 The Legal Counsel received the Certified Payout Statement in his Documents section. When 

the period of validity of the Certified Payout Statement has expired, the Legal Counsel must make 

a new request. 

(5) Reimbursement information sent to the Lender 

 The Legal Counsel sends to the Lender information about the reimbursement and shall pay the 

same way it did before.   

(6) Reimbursement information received by the Lender 

 The Lender checks the information relating to the reimbursement and validates the amount 

received.  

(7) Authorization to Discharge sent by the Lender 

 The Lender must, within 2 working days of confirmation of payment, sent the Authorization to 

Discharge to the Legal Counsel.  

(8) Authorization to Discharge received on Assyst Real Estate  

 The Legal Counsel received the Authorization to Discharge and the Resolution Document. He 

is informed by a message in his Note section on Assyst Real Estate.  

(9) Discharge Registered 

 The Legal Counsel prepares the Discharge (partial or total), and the document is signed by the 

authorized person.  

 He sends the Discharge electronically to the Land Register via Assyst Real Estate for registration 

purpose. 

(10) Discharge Registered  
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 The Legal Counsel selects the Discharge Registered status and the information relating to the 

discharge registration is send to the Lender. 

 End of process. 

The Discharge Solution allows you to follow different steps to request a discharge of one or more 

debt relating to your file.   

Regarding the Discharge Solution, the majority of the information you need to complete your file are 

under the tab Additional Information.  

Completing the Discharge file 

information 
Additional Information tab on Assyst Real Estate includes sections where you must complete 

information in order to follow the management process of Discharge. The following sections are 

particularly associated with the Discharge Solution:  

 Legal Description 

 Current Registered Owner(s) 

 Interest to be discharged 

 

The information you enter in the different sections will be sent to the Lender, when forwarding your 

Request for Payout Statement.  

That information will be merged into the different documents related to the Discharge Solution and 

are presented in Documents section. 

Legal Description 

For more details on the features of the Legal Description section, see the Legal Description section 

on Chapter 8.  
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Current Registered Owner(s) 

You access the Current Registered Owner(s) section by clicking the arrow on the left side. 

The Current Registered Owner(s) section allows you to enter or modify the information related to the 

Previous Borrower. You enter information on all borrowers (borrower, guarantor or commercial) for 

which you must send a Payout Request.  

The name of each Previous Borrower that you enter in the Current Registered Owner(s) section is 

displayed in the Interest to be Discharged section allowing you to select it at this point. 

The Current Registered Owner(s) section contains the following components: 

 

 In the Current Registered Owner(s) section, only the name of the Borrower is mandatory. 

Information entered in the Address section and phones section are for information purposes 

only.  

 By default, the address displayed in the Address section is the same as that presented in the 

Property section of the Mandate page. It can be modified, if necessary. 

The table below provides a description of the main fields available in the Current Registered 

Owner(s) page:   
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Field Description 

Borrower Click the button to select the Borrower option 

Guarantor Click the button to select the Guarantor option 

Commercial Check the box to select the Commercial option 

Note : Be sure to confirm if the Commercial is a  Borrower 

or a Guarantor 

First Name / Name Enter the First Name and the Name of the Current 

Registered Owner (mandatory field) 

Address Enter the Address, the Province, the Country and the Postal 

Code of the de Current Registered Owner 

Phone Numbers Enter the Home Phone,  the Office Phone and the Cell Phone 

of the Current Registered Owner 

 

 

When you select the Commercial option, a warning message displayed:  

 

If you confirm, the Commercial box is checked.  

 Be sure to confirm if the Commercial  is a Borrower or a Guarantor 

The Representative section displayed on the right allows you to add information about Commercial.  

You can enter up to 3 representatives per company. 
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For each Representative, you must complete the following information: 

Field Description 

Borrower Click the button to select the Borrower option 

Guarantor Click the button to select the Guarantor option 

Commercial Check the box to select the Commercial option 

Note : Be sure to confirm if the Commercial is a Borrower or 

a Guarantor 

Company Name Enter the Company Name. (Mandatory field) 

Name of the Contact Given by 

the Financial Institution             

______________________ 

First / Last Name 

 

 

Enter the First Name and the Last Name of the Contact given 

by the Financial Institution 

Home Phone Enter the Home Phone of the Contact 
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Office Phone Enter the Office Phone of the Contact 

Cell Phone Enter the Cell Phone of the Contact 

Language Click the button to select the Language (French or English)  

Address Enter the Address of the Company 

City Enter the City of the Company 

Province  Use the scroll down menu to choose the Province of the 

Company  

Country Use the scroll down menu to choose the Country of the 

Company 

Postal Code Enter the Postal Code of the Company 

Representative 

____________________ 

First / Last Name 

 

Enter the First Name and the Last Name of the 

Representative (You can enter up to 3 representatives per 

company) 

Title Enter the Title of the Representative 

Home Phone Enter the Home Phone of the Representative 

Office Phone Enter the Office Phone of the Representative 

Cell Phone Enter the Cell Phone of the Representative 

 

Click the arrow on the left of the name to expand the information about the Current Registered 

Owner. 

The Add button allows you to add a previous borrower. You can add up to 10 Current Registered 

Owner. 

The Remove button allows you to remove a Current Registered Owner.  

 If the Current Registered Owner is already selected in the Previous Lender page, you will not 

be able to remove it. 
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Previous Lender 

You access the Previous Lender section by clicking the arrow to the left of Previous Lender section 

under the Interest to be discharged tab. 

The Interest to be discharged section allows you to research select and add information about the 

previous lender. This information will be useful to prepare and process your Discharge file.   

This section contains the 3 following main parts: 

 Registered Lender: allow you to get the name and details of the current Lender by researching 

and selecting the name of the lender as written on the discharge document.  

 Details: allow you to select and enter information that will be forwarded to the Lender when 

sending the Request for Payout Statement. 

 Status: allow you to follow the steps related to the management process of Discharge. 
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For each Request for Payout Statement that you want to send, you must complete or select the 

following information fields: 

Field Description 

Registered Lender Allows to research the name of the lender as written on the 

discharge document. (This information is displayed after you 

research the Lender using the Research button to right field) 

Lender Info Displays the Info of the lender (name and current address of the 

Lender) concerned by the Payout Request 

Payout Request Sent Allows to select and indicate that the Payout Request was 

forwarded to the Lender 

Certified Payout Statement 

received 

Displays that the Certified Payout Statement was received 

Reimbursement Allows to select and indicate that the reimbursement was made  

No Outstanding Balance Allows to indicate that there is no amount due to the Lender 

Money sent to Lender, reference Allows to indicate that the repayment has been made to the 

Lender 

 Allows to enter the reference number regarding the payment 

method 

Amount sent to Lender Allows to enter the refund amount given to the Lender 

Authorization to Discharge  Indicates that the Authorization to Discharge has been received 

Discharge Registered Allows to select and indicate that the Discharge has been 

registered 

Discharge Registration # Allows to indicate the Discharge Registration number 

Publish Date Allows to indicate the Discharge Publish Date 

Type  Pull-down menu allowing you to choose the type of Discharge 

document (full or partial) 

Statement required for Allows to indicate the date for which the statement is required 

Comment to Lender Allows to enter additional information to the Lender (text field) 

Legal Description Allows to select the Legal Description of the property referred by 

the Payout Request 
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Previous Borrower(s) Allows to select Previous Borrower referred by the Payout Request 

Nature of Document Pull-down menu allowing you to choose the nature of Document 

Registered Amount Allows to indicate the amount of the guaranty as written on 

discharge document 

Registration # Allows to indicate the Discharge Registration number 

Registration Date Allows to indicate the Discharge Registration date 

Registration Division Pull-down menu allowing you to select the Registration Division 

where the Discharge was registered 

Add or Remove a Previous Lender 

 

The arrow to the left of the name allows showing or hiding information about Previous Lender. 

The Add button top right of the page Previous Lender allows you to add a Previous Lender. You can 

add up to 10 Previous Lender. 

 Add a Previous Lender 

1. Click on the Add button.  

A new Previous Lender section is added. 

Information about Legal Description and Current Registered Owner(s) previously entered in the 

Legal Description and Current Registered Owner(s) pages are automatically displayed in the new 

Previous Lender section. You can select Legal Description and Current Registered Owner 

concerned by this request.   

You must also research and select a new Lender in the Registered Lender section. 

The Remove button allows you to remove a Previous Lender section.  

 Remove a Previous Lender 

1. Click on Remove button at the top right of the Previous Lender section.  

The Previous Lender section is removed. 
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 If there is only one Previous Lender section, you cannot remove it. 

 If the Payout Request has already been transmitted, you cannot remove it. 

Research the Previous Lender 

The current name of the Previous Lender may differ from the name of the Lender written on the 

Discharge document. You can get the current name and address of the Previous Lender by 

searching using the Search button to the right of the Registered Lender field. 

 Research the Previous Lender 

1. Click on Search button. 

 

The window Registered Lender Search is displayed. 

2. Enter the name of the Lender that you research in the Name field and click on the Search 

button. (You must enter at least the first 2 letters to the Lender's name appears) 

The name of the Lender matching your search criteria appears in the same window in the section 

Registered Lender.   

 

3. Select the name appearing under the column Registered Lender. 

The name and address of current Lender appear in the text box Lender Info. 
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 All information required to complete the appearance will be forwarded in the Certified Payout 

Statement and will be merged in the Discharge document. 

When you select the Previous Lender, a sequential number, given by the system, is displayed in the 

header of the Previous Lender section. 

 

Details 
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 Type: this pull-down menu allows you to select the type of discharge requested, (partial or full 

Discharge). 

 Statement required for: this field allows you to enter the date for which the statement is 

required.  

 Comment to Lender: this text field allows you to enter additional information that you want to 

bring to the attention of the Lender when you send the Certified Payout Request. 

 Legal Description: in this section you can select, using checkboxes, the lot corresponding to the 

property covered by the Payout Request. 

The Legal Description displayed in the window match the information entered in the Legal 

Description section under the Additional Information tab. 

 

 

 Previous Borrower(s): in this section you can select, using checkboxes, the name of the 

Previous Borrower referred by the Payout Request. 

The Previous Borrower displayed in the window match the information entered in the First / Last 

Name or Company Name (case of company) in the Current Registered Owner(s) section under 

Additional Information tab.   

 

      

 You must select at least 1 Previous Borrower in order to submit a Request for Payout Statement 

to the Lender. 

 Nature of Document: this pull-down menu allows you to select the nature of discharge 

requested (ex: hypothec, subrogation, etc.). 

 Registered Amount: this field allows you to enter the amount of the guaranty as written on the 

Discharge document. 

 Registration #: this field allows you to indicate the Discharge Registration number 

 Registration Date: this field allows you to indicate the Discharge Registration date. 

Legal Description Previous Lender 

Current Registered Owner(s) Previous Lender 
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 Registration Division: this pull-down menu allows you to select the Registration Division where 

the Discharge was registered. 

Complete the steps and follow up 

Status 
The treatment of Discharge file on Assyst Real Estate requires to follow a process and complete 

different steps as they are introduced. For each status completed, a checkmark appears in the 

checkbox and also the date and time are displayed at the right of the status.   

Most steps require that you take action, except for statutes Certified Payout Statement received 

and Authorization to Discharge, where the box will be checked following the action of the Lender. 

The different status 

Each status is presented chronologically and the second cannot be activated before the first and so 

on.  

The status displayed in blue are those for which you must take action (Payout Request Sent, 

Reimbursement, and Discharge Registered). Once the action is taken, the box is checked, the 

status is displayed in gray, and the date and time are presented to the right of the status.  

The status Certified Payout Statement Received and Authorization to Discharge are displayed in 

gray because you cannot take action for these steps. The box to the left of status will be checked by 

the system only when Certified Payout Statement received and Authorization to Discharge will 

have been sent by the Lender. 

In the Status section, the following statuses are presented and checkboxes indicate the different 

stages of the process where an action has been or shall be taken: 
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The following sections show the different status and the factors that allow you to complete the 

actions.   

Payout Request Sent 

It is the first status in the process of management of Discharge file. It is displayed in blue. You must 

ensure you have selected the Previous Lender and have completed all information in the Details 

section of the request before submit your Request for Payout Statement.  

Then, you can select the status Payout Request Sent and complete the information regarding the 

payment.  For more details on the information of payment, see section Modifying your payment 

information (notary/lawyer) in Chapter 4.  

If these steps are completed successfully, the box Payout Request Sent will be check, the status will 

be in gray and the date and time will be display at the right of the status.  

 Send the Payout Request 

1. Click on Payout Request Sent status. 

 

The window Sent request for payout statement is displayed. 

2. Complete the information in the Send request for payout statement window  
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 The amount paid when you submitted the Payout Request includes free of transmission for 

publication to the Land Register. 

3. Click on Accept button. 

The payout request is sent to the Lender. 

The Payout Request Sent box is checked and date and time are displayed at the right of 

the status.  

 

Once the Payout Request is sent to the Lender, the Request for Payout Statement summary is 

available in the Documents section under the heading Request for Payout Statement. This 

summary display information includes in the Registered Lender and Details sections in the Interest 

to be discharged page. The Payout Statement sending date is displayed in the Status section. 

 The Request for Payout Statement summary is displayed in PDF and cannot be changed or 

refreshed. 

If no record match with the information received, the Lender click on No File Found button and you 

will receive a note to that effect in your Note section. You can resubmit a new amended request for 

the same file. 

 The delay for submitting the Certified Payout Statement may be different depending on the 

Lender. 
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Bundled Discharges 

If you send more than one Payout Request for the same file, you can decide to bundle them.   

If you add a new request that meets the conditions listed below, the following message appears: You 

previously created a discharge with the same Lender Info (Lender info). Do you want to bundle this 

discharge with the discharge number (Discharge number).  

If you confirm, your new Request is bundled with the request whose number is given, which is the 

main request. 

Only one Certified Payout Statement bundling these requests, will be sent to you. 

The conditions are : 

 The Lender is the same for each Payout Request.  

 The Legal Counsel is the same for each Payout Request.  

 The status Payout Request Sent should not have been set off for the requests you want to 

bundle. 

 For all Payout Request, the type of Discharge is the same (partial or full discharge). 

The Request for Payout Statement on which one or more request has been bundled is the Main 

Request.  The status management will be done from the Main Request. 

You must first have completed all mandatory fields of bundled request before send your Payout 

Request. 

The title Bundle with discharge number: XXXX is displayed in the header of the section to indicate 

with which request the new request has been bundled.  
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Certified Payout Statement Received 

Receive and consult the Certified Payout Statement 

After examining the Payout Statement Request, the Lender complete information of the 

Reimbursement Details section and send the Certified Payout Statement to the Legal Counsel. 

A message is displayed in your Note section to advise you that you have received Certified Payout 

Statement.  

  

The Certified Payout Statement is automatically generate and available in your Documents section 

under the name of the Lender.  

 

The Certified Payout Statement Received status is displayed in grey because you do not take 

action for this step. Once Certified Payout Statement has been sent to you by the Lender, the box 

Certified Payout Statement Received will be check by the system and date and time will be 

displayed at the right of the status.  

 

Reimbursement 

After reading the information contained in the Certified Payout Statement, you must complete this 

step by indicating the amount you give to the Lender and the references regarding the payment.  

The status Reimbursement is displayed in blue, to indicate that you've reached this stage and you 

can choose No Outstanding Balance or Money sent to Lender. 

 The legal counsel will forward the payment to the Lender in the same way it does now; no 

payment may be transmitted via Assyst Real Estate.   
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Money sent to Lender 

If you have to reimburse the Lender, you indicate the reference number of the check or payment and 

the amount remitted to the Lender in the appropriate fields and you select the status Money sent to 

Lender, reference. Select the Reimbursement status and the box Reimbursement will be check 

automatically and the date and time will be displayed at the right of the status.  

 Money sent to Lender 

1. Enter information about reimbursement in the field Reference # and Amount sent to 

Lender. Default, the status Money sent to Lender, reference is checked. 

2. Click on Reimbursement status.  

The box Reimbursement is automatically checked and sending date and time are displayed 

at the right of the status. 

 

The information regarding the reimbursement is then forwarded to the Lender. 

 If the Lender gave you more than a Certified Payout Statement for the same file, you can merge 

the amounts and send one check or payment to the Lender. 

No Outstanding Balance 

If the Certified Payout Statement indicates that no amount is owed to the Lender, you must select the 

status using the button No Outstanding Balance. Then, select the status Reimbursement and the 

box Reimbursement will be automatically checked.  

 No Outstanding Balance 

1. Select the No Outstanding Balance status.  

2. Select the Reimbursement status and the box Reimbursement is automatically check by 

the system. 

The information regarding the reimbursement is then forwarded to the Lender. 
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Authorization to Discharge 

The Lender agrees, within 2 business days of payment confirmation, to send to the Legal Counsel 

the Authorization to Discharge. 

The Authorization to Discharge is displayed in grey because you do not take action for this step. 

Once the Authorization to Discharge have been sent to you by the Lender, the box Authorization to 

Discharge will be checked by the system and the date and time will be displayed at the right of the 

status.  

 

A message appears in your section Note to advise you that you have received the Authorization to 

Discharge and the Resolution Document in your Documents section. 

The Authorization to Discharge and the Resolution Document are available in your Documents 

section.  

Generate the Discharge 

The Discharge document is available in your Documents section under the header Mainlevée Partial 

or Complete.  

 

Make sure you have correctly completed the information fields in File tab and Additional Information 

tab before generating the required document, so you do not have any missing information. 
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All information required to complete the Discharge will be merged into the document, based on 

information entered by the Lender. 

 The Discharge document is available in the Documents section at the beginning of the process. 

However, the better practice is to generate it at the end of the process to have no missing 

information in the document. 

Discharge Registered 

It is the last status of the Discharge process. This status is use to inform the Lender that the 

Discharge was registered. The status Discharge Registered is displayed in blue to indicate that you 

need to intervene at this stage of the process.  

 This operation can be completed only if the status Authorization to Discharge is checked. 

 

The field Discharge Registration # allows you to enter the Discharge registration number given by 

the Land Register. The field Publish Date allows you to enter the Discharge registration date given by 

the Land Register.   

 Although this information is optional, if the field No de publication is completed you must 

complete the field Publish Date and vice versa. 

 Discharge Registered 

1. Enter the Discharge registration number and the registration date of the Discharge 

document. (this information is optional.) 

2. Click on Discharge Registered status.  

The box Discharge Registered is automatically checked and date and time are displayed at 

the right of the status. 

 

For more information about registration purposes, refer to Registering Documents Online (Québec) in 

Chapter 8. 
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Managing Discharge documents 
Documents related to the Discharge Process are displayed in the Documents section as soon as you 

have selected a previous lender in the Previous Lender section.   

Some of those documents are automatically generate by the system or may be generated steps as 

they are introduced.  

The Discharge files are presented in the list by order of request number. The information in 

parentheses to the right of each Discharge file indicates the number of the request and the name of 

the Lender.  

For more information about Documents section, refer to Working with Documents in Chapter 8.  

 

 

The following documents are available in each Discharge file. Some of them are automatically 

generated by the system or may be generated at the step as they are introduced: 

 Request for Payout Statement 

 Certified Payout Statement 

 Delegation of Signature 

 Mainlevée partial or complete 

 Resolution Document 

The Request for Payout Statement is automatically generated by the system and is available as 

soon as you have completed all information in Previous Lender and you submit the Payout 
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Request. This document is a summary of information entered in the Previous Lender section. It is in 

PDF format; it is not editable and cannot be generated again. 

The Certified Payout Statement is automatically generated by the system once it is sent to you by 

the Lender. It is in PDF format and is not editable This document contains all information relating 

Lender and Legal counsel contact details ; information about dates; detail of the interest to be 

discharge and detail of reimbursement.   

 The Certified Payout Statement may contain details of several credits. 

The Delegation of signature is automatically generated by the system once it is sent to you by the 

Lender.   

The Resolution Document is automatically generated by the system and is enclosed to the 

Delegation of signature once it is sent to you by the Lender.   

The Discharge document (full or partial as applicable) is available in the Documents section. You 

can edit this document. 

 Although the Discharge document is available in the Documents section at the beginning of the 

process, it is suggested to generate this document at the end of the process. 

  



Reference Guide  Assyst Real Estate 

 

126 
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Chapter 8 
Processing Current Files 

The objective of this chapter is to explain how you can work with your files and handle them. All the 

functions related to the processing of your files are presented in this chapter. 

Depending on their access rights, legal assistants can process current files in the name of the 

lawyers/notaries they work for. 

About Current Files 

Characteristics 

Current files correspond to the files that you have accepted. They are classified by financial institution 

in the list of your files and differ clearly from new files by their blue color. For every financial institution, 

the number of available files is indicated to the right of the name of the institution. Files are sorted out 

by TELUS file number or by borrower's name. This sorting can be modified by clicking the sorting 

arrow. 

  Current files are displayed under the name of the lawyer/notary who is responsible for them in 

case of file sharing (for legal assistants for instance). 

For every file, the TELUS file number and the borrower names are displayed. 

The files with notes that are not read are indicated in a different blue color and have a  symbol on 

their right side. The file that is currently selected is highlighted in white in the list of files 

 

Borrower name

Sort order

File currently selected 

highlighted in white

Number of files for the 

financial institution

Emergis file 

number

Click to expand the 

list of files

Click to hide the 

list of files

Note symbol for the 

financial institution and 

the file (not yet read)
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For more details on the functions associated with files, refer to the Using the File Functions section. 

When you select a current file in the list of your files, it is highlighted in white and the details of the file 

are displayed on the right pane. It includes the following information: 

 4 tabs to manage efficiently the information: File, Additional Information, Documents, Notes.  

 The TELUS file number and the borrower's name. 

 Information sections (general information, borrower, property, etc.). This information can be 

modified if necessary. 

 A "Status" section where you can follow the file processing steps. 

 2 functions: Save and Cancel to be used to save or cancel the modifications you add to the file. 

 

 Note: If you do not see all the information on your screen, use the vertical scroll bar on the 

right side of the window to display the information available at the bottom of your screen.  

Consulting Current Files 
 To consult a current file 

1. Click the  sign to the left of the financial institution name for which you want to see the list 

of files. This will expand and display the list of files for this specific financial institution. 

2. In the list of files, click to select the name of the specific file you want to consult. The file that 

is selected is highlighted in white in the list of files. The information related to this file is 

displayed on the right pane.  

Currently 

active tab

File currently selected 

highlighted in white

File number

Borrower 

name
Tabs Save and Cancel buttons used 

when editing the page

Information sections for 

the file that is selected

File status zone

Vertical scroll bar to move up and 

down the information in the page
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3. Use the scroll bar on the right side of the page to move vertically in the Assyst Real Estate 

window and display the information at the bottom of the page. 

4. Click the different tab to display the corresponding information pages. 

5. Repeat steps 1 to 5 do consult another file from another financial institution. 

Understanding File Statuses 
When handling a file in Assyst Real Estate, you have to follow a specific process and complete 

different steps. You will find in the Status section of the File page the list of the different file status 

supported in Assyst Real Estate. These status can be used as guidelines for you to follow the Assyst 

Real Estate steps and to help you know where you are in your file processing. 

You will find in the Status section the following five main steps: 

 File Accepted  

 Appointment with Customer Confirmed (Desjardins) or Request Final Lender Update (Banks) 

 Preliminary Report Transmitted 

 Final Report Transmitted 

 File Closed 

When a step is completed, its status is checked and the time and date it has been completed is also 

indicated. 

 

Depending on the status, you or the system will complete the step and check the corresponding 

boxes in the Status section of the File page: 
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 You will check the following steps: Appointment with Customer Confirmed, Request Final Lender 

Update and File Closed. These steps are displayed in blue. 

 The system will check the following steps depending on your actions in the system: File 

Accepted, Preliminary Report Transmitted and Final Report Transmitted. These steps are 

displayed in gray. 

Once a step is completed and the box is checked, it cannot be undone. 

The next sections will describe the different steps in details and the factors to complete every step. 

File Accepted 

This is the first status when you accept a file. The File Accepted box is automatically checked by the 

system at the end of the file acceptance process. The date and time the file has been accepted are 

always indicated to the right of the status.  

Refer to the Accepting a New File section for more details on the file acceptance process. 

 

Appointment with Customer Confirmed (Desjardins) 

This status is only available for Desjardins files. You have to activate yourself this status when you are 

ready to block the access to the file to the lender. 

Check the Appointment with Customer Confirmed box 2 business days before the signature of the 

mortgage deed. The access is immediately blocked and the bank can not modify anymore the file via 

Assyst Real Estate. 

Once the access is blocked, you can start generating your documents. 
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 Note: It is important to respect these delays and not to block the access too much in advance 

because it can lead to complications for the customer. 

 Note: A padlock symbol       will appear next to the status Appointment with Customer 

Confirmed to indicate that the lender can not modify anymore the file via Assyst Real Estate.  

Request Final Lender Update (Bank) 

This status is available for bank files. You have to activate yourself this status when you are ready to 

block the access to the file to the lender. 

Check the Request Final Lender Update box 3 business days before the signature of the mortgage 

deed. The bank has one business day to modify the file then the access is blocked. 

Once the access is blocked, you can start generating your documents. 

 Note: It is important to respect these delays and not to block the access too much in advance 

because it can lead to complications for the customer. 

 Note: A padlock symbol       will appear next to the Request Final Lender Update to indicate 

that the lender can not modify anymore the file via Assyst Real Estate.  

 

Preliminary Report Transmitted  

The Preliminary Report Transmitted box is automatically checked by the system when the 

preliminary report has been generated, signed and sent. The date and time the report has been 

transmitted is always indicated to the right of the status confirming that that bank has received it. 

 Note: You can generate the preliminary report prior to blocking the access to the lender. 

Assyst Real Estate has no restriction on the delay for generating and signing the preliminary 

report thus you can complete it as soon as you have the necessary information.  

For more details on the generation and signing processes, refer to the Generating Documents and 

Signing Documents sections.   
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Final Report Transmitted 

The Final Report Transmitted box is automatically checked by the system when the preliminary 

report has been generated, signed and sent. The date and time the report has been transmitted is 

always indicated to the right of the status confirming that that bank has received it. 

You can generate the final report as soon as your documents are registered and all your signatures 

are received. 

File Closed 

This is the last step in the file handling process. You have to activate yourself this status when you are 

ready to close the file.  

When you check the File Closed box, the date and time the file is closed is saved. The file is 

removed from the list of your files. 

Make sure to keep a copy of your documents and to have the latest version of the specific mandate 

before closing a file because you will not be able to access once it will be closed. 

Save the documents to be kept on your computer before closing the file. Open them with Adobe 

Reader or Microsoft Word (Quebec), choose  and select a destination folder on your 

computer. 

For more details on closing files, refer to the Closing File section.  

 Note: A file is automatically closed and removed from the list of your files 6 months after the 

final report has been generated, signed and sent. 

Consulting / Completing the File 

Information 
The objective of this section is to present the information available for every file in the File and 

Additional Information tabs that you have to consult and/or validate.  

Some of this information is validated by you and updated if required, other is completed by the 

financial institution and available for consultation only. 
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General Information 

The General Information section is available in the File tab. This section provides information on the 

file status and on the financial institution.  

Most of the information of this section is in reading mode only and for consultation.  

 

You will find in the following table explanations on every field available in the General Information 

section. 

Field Description 

File No. TELUS file number automatically created by the system. 

You have to use this number when communicating with the Assyst Real 

Estate Service Desk in case of problem or when having a question relative to a 

specific file. 

Program Type of file. 

Loan No. Financial institution's file number (to use when communicating with the 

financial institution). 

Date File Received Date and time the file was received in Assyst Real Estate. 

Last Lender Update Date the lender modified the file for the last time. 

Legal Counsel Name of the legal counsel 

Internal File No. Number of file for internal use 

Financial Institution Name of the financial institution which assigned the file to you.  

When you click the Appearance link, a window is displayed providing 

information on the lender appearance. 
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Service Center 

Transit 

or 

Branch Transit 

The transit number of the financial institution which assigned the file to you.  

When you click the Details link, a window is displayed providing information 

on the lender.  

Contact Name Name of the financial institution contact with his phone number and his e-mail 

address. 

Appearance and Institution Details 

 

1. In the General Information section, click the Appearance link to the right of the Financial 

Institution field. 

 

This will open the Appearance window where you find the information relative to the Appearance of 

the lender (Financial Institution, Name, Notice of Address, and Address). 

2. Click the Details link to the right of the Service Center Transit field. 

Click to open 

Appearance window 

where you find the 

Appearance of the lender

Click to open the Details 

window where you find 

the Institution Details
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This will open the Institution Details window where you find the information relative to the Institution 

Details (Financial Institution, Name, Service Center Transit, Phone, Fax, Communication Mode, E-

mail, and Address). 

3. Click the Details link to the right of the Branch Transit field. 

 

This will open the Institution Details window where you find the information relative to the Institution 

Details (Financial Institution, Name, Branch Transit, Phone, Fax, Communication Mode, E-mail and 

Address). 

4. Click on Close button. You are back to the General Information section. 

Particular Remarks 

You find in the Particular Remarks section the remarks entered for the file by the financial institution.  

The content of the Particular Remarks sections is always read-only and you cannot enter or modify 

anything. This section includes information entered by the financial institution (remarks, references, 

etc.).  



Reference Guide  Assyst Real Estate 

 

136 

 

Warranty 

The information relative to the warranty of the mortgage is available in the Warranty section of the 

File tab. 

This information is completed by the financial institution and you cannot modify it. 

 

Borrower(s)  

The section relative to the borrowers is available in the Borrower(s) sections of the File tab. This 

section provides all the information about the borrowers, co-borrowers, grantors and sureties. This 

information can be modified if required. It will be used when generating the documents for the file. 

 To modify the borrower information 

1. Select a file in your list of files. 

2. Make sure the File tab is selected. 

3. In the Borrower(s) section, depending on the type of the file, you will find a description of the 

main borrower, the co-borrowers, grantors, sureties, etc. 

 

The choices are displayed through expandable zones. You have to click the name of one of 

the entry or the arrow on the left side  to display the corresponding information. 

For more details on expandable zones, refer to the Expandable Zones section. 

4. Click, for example, the Borrower name or the arrow on its left side . This will expand the 

information associated with the borrower. The arrow head is blue and is displayed 

downward. 
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5. Complete the information in the various fields. This information will be used and merged 

when you will generate the documents associated to the file.  

6. Repeat the process (steps 4 and 5) for every borrower if required. 

7. Click the Save button at the top right side of the page to save your modifications. 

 

 

Points to Note   

 If you have to add an address other than Canada and US, select Other in the Province field, 

then enter the name of the province in the Other province field and select Other in the Country 

field and enter the name of the country in the Other country field. The postal code is not 

validated in this case. 

 

 In the case of a natural person, you can complete the First Name, Last Name and Job Title 

fields in the To Complete where  Spousal consent is required section. These data will be 

automatically merged at the correct position in the documents you will generate. 
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 In the case of a natural person again, for a co-borrower, grantor or surety, you can check the 

Same Address as the Main Borrower box in the Address section and the address will be 

automatically completed with the data coming from the main borrower's address. 

 

 In the case of a legal person, for a main borrower, you have to be aware that the information 

entered in the Name of the Contact Given by the Financial Institution section is not used 

anywhere in the merging process. You have then to make sure to enter in the Representative 1, 

Representative 2 and Representative 3 sections the information about the persons who will 

sign the deeds. 
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Switch to Guarantor or Switch to Borrower (British Columbia and Ontario)  

The Switch to Guarantor or Switch to Borrower checkbox allows lawyers/notaries to switch a 

borrower to a guarantor, or a guarantor to a borrower, based on client instructions.  The change in 

status is only allowed when a minimum of one borrower exists on a file after the switch is completed.  

Otherwise, the change in status will be refused.  

 

Whenever borrower or guarantor status is changed, any documents previously generated will have to 

be re-generated.   

 

Properties 

The section relative to the property(ies) used in guarantee is available in the Property 1 and Property 

2 sections of the File tab. These sections provide detailed information on the address(es) of the 

property(ies) that the financial institution wants to have in guarantee (maximum 2 properties). 

The information available in the property section can be partially modified. This information will be 

used when generating the documents associated to the file. 

 To complete the property information 

1. Select a file in your list of files. 

2. Make sure the File tab is selected. 

3. In the Property 1 section, complete the information relative to the property address that the 

financial institution wants to have in guarantee. Complete the Property 2 section if required. 

 

4. Click the Save button at the top right side of the page to save your modifications. 
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Loan 

The section relative to the loan is available in the File tab under the Loan section.  

This section provides all the bank details relative to the loan. This information is completed by the 

financial institution and you cannot modify it. 

 Note: In the Loan section, N/A is displayed when a field in not used by the lender.  

The number of days indicated in the Retained % up to field depends on the province in which 

the property address is located.  

 

Monthly Frequency  Alt. Frequency (As Per Borrower) 

The section relative to the payment frequency is available in the File tab under the Monthly 

Frequency  Alt. Frequency (As Per Borrower) section.  

This section provides the information about the customer's payment frequency, the payment date 

and the payment day, the amounts paid according to the frequency and the first payment day. This 

information is completed by the financial institution and you cannot modify it. 

 Note: In the Monthly Frequency  Alt. Frequency (As Per Borrower) section, N/A is 

displayed when a field in not used by the lender. 
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Funding Date and others dates 

The section relative to the loan funding date and other dates is available in the Dates section of the 

File tab. This section provides the information about the following dates:  

 Funding date 

 Interest Adjustment date 

 First Payment date 

 Last Payment date 

 Mortgage Signature date 

The information relative to the dates is completed by the financial institution but can be modified by 

the legal counsel. The date information will be used when generating the documents associated with 

the file (Loan Contract and Cost of Borrowing). 

 To modify the Funding date and the other dates 

1. Select a file in your list of files. 

2. Make sure the File tab is selected. 

3. In the Dates section, complete the four date fields under the Legal Counsel column. You 

can use the calendar option to select every date and complete the fields. Refer to the 

Calendar section for more details on the calendar functioning. 

 

4. Click the Save button at the top right side of the page to save your modifications. 

 Concerning Laurentian Bank, you only have to complete the Funding field. The other fields will 

be calculated automatically. 
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Contracts (Enterprise Files) 

In the case of a commercial file, an additional section is available at the bottom of the main page of 

the File tab. This section is about contracts and is named Contract(s). This section supplies the list of 

the contracts that have to be signed. 

Contracts can be of 2 types: new or already existing. If there are existing contracts, the financial 

institution will let you know and will indicate the transmission method. 

The Contract section provides the following information:  

 The type of every contract type (you can have more than one contract). 

 The amount of every contract. 

 The signature date of every contract (optional and can only be completed for new contracts). 

 

Additional Information 

The Additional Information section of Assyst Real Estate includes external stakeholders involved in 

the file process and providing services or information required for processing Mortgage file and 

Discharge file that can be published online via Assyst Real Estate. 

 

Each section allows you to enter information regarding Legal Description, Current Registered Owner, 
Interest to be discharged and Title Insurance. 

 The following choices are available depending on the financial institution and the province:  

 Legal Description 

 Current Registered Owner(s) 

 Interest to be discharged 
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 Title Insurance 

 

 To display the additional information  

1. Select a file in your list of files. 

2. Click the Additional Information tab to select it.  

The choices are displayed through expandable zones. You have to click the name of one of 

the entry or the arrow on the left side  to display the corresponding information. 

For more details on expandable zones, refer to the Expandable Zones section. 

3. Click, for example, the Legal Description name or the arrow on its left side . This will 

expand the information associated with the legal description. The arrow head is blue and is 

displayed downward. 

 

4. Click again the Legal Description name or the arrow on its left side . This will hide the 

information associated with the legal description. The arrow head is black again and no 

longer displayed downward.  

5. Repeat the process for the other choices.  

6. Click the Save button at the top right side of the page to save your modifications. 

Legal Description 

The section named Legal Description, available in the Additional Information tab, provides the 

information about the legal description required in the mortgage file and discharge file. The legal 

description identification is automatically completed (Registration Division section). You must ensure 

the information is valid and modify the data if required.  

The information will be added in the mortgage deed or discharge document at the correct position 

during the merging process. 

 



Reference Guide  Assyst Real Estate 

 

144 

 

Part of Lot 

When you check the box Part of Lot the text box Legal Description is displayed allows you to enter 

the Legal Description of the part of Lot. 

 

The table below provides a description of the main fields available in the Legal Description page. 

Some of the fields have to be completed in a logical order that is explained below. 

Field Description 

Registration Enter the registration number and date for the mortgage deed and deed of 

sale 

Registration Division Select in the drop-down list the name of the Registration Division.  This step 

has to be done first. 

Cadastre Select in the drop-down list the name of the cadastre. The content of the list 

depends on the Registration Division you have selected at the previous step 
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in the Registration Division field.  This is the second step you have to 

complete. 

Lot Enter the lot number. Do not use letters except if it is a part of the lot 

number.  

You can enter only one lot number per Lot field. You can define up to nine 

lots per property. 

Secondary 

Description 

Select in the drop-down list the name of the secondary description. The 

content of the list depends on the cadastre you have selected at the second 

step. This is the third step you have to complete. 

Part of Lot Check the box to indicate that it is a part of a lot. The text box Legal 

Description is displayed allows you to enter the Legal Description of the part 

of Lot 

Co-Ownership / 

Private Portion 

If it is a co-ownership, check the Co-Ownership box then add the lot 

numbers for the private portions (Private Portion is automatically checked). 

The first lot represents the first private portion. You can have up to 3 private 

portions. 

The information will be added in the mortgage deed at the correct position 

during the merging process. 

 

Click the Add button link to add an additional lot.  

Click the Remove link to delete a lot. 

 

Current Registered Owner(s) 

The Current Registered Owner(s) section allows you to enter or modify the information related to the 

Previous Borrower. You enter information on all borrowers (borrower, guarantor or commercial) for 

which you must send a Payout Request.  

For more details on the features of the Current Registered Owner(s) section, see the Current 

Registered Owner(s) section on Chapter 7.  
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Previous Lender 

The Previous Lender section allows you to research select and add information about the previous 

lender. This information will be useful to prepare and process your Discharge file.   

For more details on the features of the Previous Lender section, see the Previous Lender section on 

Chapter 7.  

 

Working with Documents 

About Documents 

All the documents related to a file are grouped in the Documents tab. From this tab, you can 

manage the documents required when processing a file. Documents can be in Word or PDF format 

depending on your province. 

The objective of this section is to present all the functions available in Assyst Real Estate for the 

processing of the documents linked to the files.  

The documents available in the Documents tab can be of two types: 

 Generated documents: They are created from the document templates available in Assyst Real 

Estate, every program having its set of templates. They are organized by category (loan contract, 

mortgage deed, etc.). 

The list of document categories available in the Documents tab can vary from a file to another 

depending on the file characteristics, the financial institution, the program, etc. 

The list of document categories required for a file is automatically generated by the system when 

the file is accepted. From the list of document templates for every category of documents, you 

can generate the legal documents required when processing the file. 

Some documents are automatically generated when the file is accepted: the invoice, the TELUS 

service contract, and the other documents specific to each financial institution. 

 Imported documents: These documents include bookmarks and are imported in Assyst Real 

Estate to be registered online. They are all grouped together under the Other Documents (import) 

category in the list of the documents in the Documents tab. 

For more details on the import function, report to the Importing Word Documents section. 

The operations you can make on documents include: opening, generating, modifying, signing, 

sending, registering, visualizing, saving as and transferring a document.  

The information displayed in the Documents tab is organized as following:  
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 The list of documents associated to the current file is displayed on the left pane, this list being 

organized by category. The document categories that have a  sign to their left include 

generated documents. 

 The list of functions available for every selected document is displayed on the right pane (open, 

generate, register, etc.). The functions that are enabled are in blue, the disabled ones are in gray.  

 The name and the language of the legal counsel in charge of generating the documents is 

displayed under the list of functions. By default, this is the name of the current user of Assyst 

Real Estate but another name can be selected. 

 The information relative to the selected document is displayed on the right pane under the 

Document Details section: file name, version, language of the document, creation date, author 

(name of the lawyer/notary who created the document. 

 The information relative to the transmission is displayed in the Transmission Information section: 

recipient name, e-mail, sender name, document transmission date. This information is only 

displayed when selecting a document that has been sent. 

 

 

Information about the 

transmission of the document 

(send function)

Information about the 

selected document

Document currently 

selected is highlighted

Specific category for 

imported documents

List of document categories 

for the current file

List of the functions available for 

managing the documents (gray when 

disabled)

Information used when 

generating a document
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Displaying Generated Documents 

To maximize your workspace and only display the appropriate information, the list of documents is 

always minimized and only the categories of documents are displayed. The documents belonging to 

these categories are not automatically displayed. 

 To display generated documents 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 

The categories having a  sign to their left include generated documents. 

3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  A list of documents is displayed. A  sign is then displayed to 

the left of the category name meaning the list is expanded. 

4. Repeat the process to display and hide the documents existing for the different categories. 

 

Opening Documents 

As soon as a document is generated, you can open it. 

 To open a document 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 

The categories having a  sign on their left side include generated documents. 

The – symbol is displayed when the list of 

documents generated for a category is 

expanded. Click the – symbol to reduce 

the list)

Document already generated for this 

category and currently selected

Click the + symbol to expand 

the list of documents 

generated for this category

Categories of documents with no symbol 

on their left side meaning they do not 

have any generated documents
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3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  A list of documents is displayed. A  sign is then displayed to 

the left of the category name meaning the list is expanded. 

4. Click the name of a document to select it. It is highlighted. 

 

The information about the document is displayed in the Document Details section (file name, 

version, language, creation date and author). 

 

5. Double-click the name of the document or click the Open link to the right of the list of 

documents. 

 

The file is opened. You can consult it and print it. 

6. Close the document. You are back to the list of documents in Assyst Real Estate. 

Generating Documents 

In Assyst Real Estate, documents can be generated in Microsoft Word or PDF format, depending on 

your province. Documents generated through Assyst Real Estate always use the information included 

in the File and Additional Information tabs. This information is merged in documents at the 

appropriate positions. 

Make sure to complete correctly the required information fields in the File and Additional Information 

tabs before generating your legal documents to avoid having missing information. 

Document creation date
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Before generating a document, you have to indicate the name of the lawyer/notary who generates 

the document (it can be you or another lawyer/notary) and the language in which the document has 

to be generated (English or French). 

 To generate a document 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 

3. Click to select a category for which you are going to generate a document. The name of the 

category is highlighted. 

4. On the right panel, in the Language field, click to select the language in which the document 

has to be generated: English or French (default value). 

 

5. If the document must be generated in the name of another lawyer/notary, select the name of 

this lawyer/notary by clicking the  button on the right of the Legal Counsel field. 

The Legal Counsel Search dialog box is displayed. 

Name of the Legal Counsel 

used when generating the 

document

Select the language in which the 

document will be generated

Click to select 

another name of 

Legal Counsel



 

 151 

 

6. Complete the criteria for your search by selecting the Province and the City (if desired) and 

by entering the first 2 letters of the Name of the legal counsel to whom to you want to 

transfer the file. 

7. Click the Search button to perform the search.  

A message is displayed if no record matches your criteria. 

 If the name of the lawyer/notary to whom you want to transfer the file is not listed, please 

contact the Assyst Real Estate Service Desk. 

The results of the search are displayed in a list.  

8. Select the name of the legal counsel you are looking for.  

9. Use the scroll bar to move up and down in the list.  

10. The Legal Counsel Search dialog box is closed and the name you selected is displayed 

right to the Legal Counsel field. 

 

11. Click the Generate link.   

Complete the criteria for your 

search. You must select a 

province and enter the first 2 

letters of the name of the legal 

counsel you are looking for

Click to perform the search

Results of the search

Click to select the name of a 

legal counsel
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This will open the Generate Document dialog box. 

This window displays the list of the information required to generate the document. This information 

comes from the File and Additional Information tabs. The missing information that is required is 

indicated. The legal counsel city of practice (found in the page My profile) is automatically inserted in 

the field Place of the last signature in the Generate a document window. You can delete this 

information from the window and complete it directly in the deed of warranty. 

The following screen is an example of a Generate Document window for a mortgage deed in 

Microsoft Word format where information is missing.  

 

12. In the case of mortgage deeds in Microsoft Word format, enter the information in the 3 fields 

marked as "Edit this input". Click the field and enter the information. The Generate button 

will be enabled only when these 3 fields will be completed. 

13. Verify that there is no field marked as "Missing Information ". 

If it is the case, you have to cancel the document generation and close the window by 

Click to cancel the 

generation process and 

close the window

Click to generate the document (the button is 

only enabled when the 3 first fields have been 

completed)

Complete the 

three fields prior 

to generating 

the document

Missing information to be 

completed prior to generating 

the document

Field  automatically 

populated with the 

city of practice of the 

legal counsel 
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clicking the Cancel button, then go back to the File and Additional Information tabs to 

complete the missing information before asking again for the document generation. 

14. The City of signature field can be editable in the dialog box. You can modify it before the 

document is generated. The field WHEREOF ACT AT in the deed document will be 

populated by the information entered in the City of signature field. 

 

15. Click the Generate button to start the generation process. 

The document is generated by retrieving the information existing in the database. The name 

of the generated document appears automatically below the document category in which it 

was created.  

Once generated, you can open the document to consult it, modify it or print it. 

Colored Texts in Documents 

The information that has been merged and inserted in the document is indicated in a different color to 

allow you to track it and verify it easily. The information is presented in 3 different formats: 

 Black text: corresponds to the data and text coming from the financial institution.  

 Blue text: corresponds to the merging data coming from Assyst Real Estate. 

 Gray text: corresponds to editable text fields that you can modify or complete. Once these fields 

completed, save the document, and then print it. 

Filling forms in PDF documents 

Some of the documents generated in PDF format can be completed in Adobe Reader once 

generated. This is the case for instance for the Form B. 

You have to open the document that has been generated and use the Adobe Reader tools to fill in 

the fields. 

Fields that are editable and that have to be checked or completed if necessary are highlighted in 

blue. Data in this field comes from the data retrieved from Assyst Real Estate. 

Use the different yellow buttons to complete the information. 

Use the Save Data button to save the date typed in the form. 
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When Information is Missing 

If some information is missing: 

 Delete the document that has been generated (Delete function). 

 Complete the missing information in the File and Additional Information tabs. 

 Generate again the document. 

 Complete the gray text fields if it applies. 

Signing Documents 

The signature function allows you to electronically sign a document and send it to the financial 

institution. This function is used for sending the preliminary and final reports. 

Use the digital signature provided by your official provider. The data associated to your digital 

signature are always encrypted to guarantee the security of the information. 

The digital signature steps are the following: 

 Generating the document (first step). 

 Adding the digital signature to the document. 

 Encrypting the document with the digital signature 

 Sending electronically the document via Assyst Real Estate to the financial institution. 

 When a document is signed the word (Signed) appears next to file name. 
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Signing Microsoft Word Documents (Quebec Only) 

This procedure applies for Microsoft Word documents using a digital signature provided by Notarius 

in the province of Quebec. 

 To electronically sign a Microsoft Word document 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 

3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  A list of documents is displayed. A  sign is then displayed to 

the left of the category name meaning the list is expanded. 

4. Click the name of a document to select it. It is highlighted. 

5. Click the Sign link to the right of the list of documents. 

   

 The Sign function is only enabled if the signature process can be done for the document that 

you have selected. 

This will open the Sign dialog box. You have then to complete the information about the 

digital signature. 

6. In the Entrust Profile field, click the Browse button to look for the Entrust digital signature 

file. This will display another window called Select File. Use the Select File window to find and 

select your Entrust digital signature file.  

The Entrust digital signature file has an .epf extension. It must be available on your 

computer in a dedicated directory.  

Browse in your directories and files, select the Entrust file then click the Open button. This 

will close the Select File window and will display the Entrust digital signature path and file 

name in the Entrust Profile field of the Sign dialog box. 

7. In the Password field, enter the password associated with your digital signature. 
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 Note: Click the Cancel button in the Sign window if you want to cancel the signing process. 

 

8. Click the Sign button to confirm the signature process and send the document to the 

financial institution.  

The signature is automatically validated by the Notarius certification agent. 

When the transmission is completed and approved, the details of the transmission are 

displayed in the Transmission Information section: the name of the recipient, its e-mail 

address and the sending date.  

 

 Note 1: As soon as a preliminary report is transmitted to the financial institution, the file status 

automatically becomes Preliminary Report Transmitted in the Status section of the File tab. 

 Note 2: As soon as a final report is transmitted to the financial institution, the file status 

automatically becomes Final Report Transmitted in the Status section of the File tab. 

Signing PDF Documents 

This procedure applies for PDF documents using a digital signature provided by your official provider. 

 To electronically sign a PDF document 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 

Click to confirm the 

signature

Click to cancel the process and close 

the window

Complete the 

information about 

your digital key
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3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  A list of documents is displayed. A  sign is then displayed to 

the left of the category name meaning the list is expanded. 

4. Click the name of a document to select it. It is highlighted. 

5. Click the Open link to the right of the list of documents. The document is opened in Adobe 

Reader. 

6. Click the Digital Signature box.  

 

This opens the Add Digital ID dialog box. 

7. Select Browse for an existing ID File and click Next. 

8. Use the Browse button to look for your digital signature file on your computer, select and 

then enter your password. 

9. Follow the different steps until you apply the signature to the document and save it. The 

signature is validated. The system confirms the signature process and sends the document 

to the financial institution. 

The system saves the document and adds it to the list of signed documents. The signature is 

then displayed in the PDF document. 
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When the transmission is completed and approved, the details of the transmission are displayed in 

the Transmission Information section: the name of the recipient, its e-mail address, the name of the 

sender and the sending date. 

 Note 1: As soon as a preliminary report is transmitted to the financial institution, the file status 

automatically becomes Preliminary Report Transmitted in the Status section of the File tab. 

 Note 2: As soon as a final report is transmitted to the financial institution, the file status 

automatically becomes Final Report Transmitted in the Status section of the File tab. 

Registering Documents Online (Quebec only) 

The registration function allows you to send electronically your documents via Assyst Real Estate to 

the Land Register for registration purpose. You will be automatically charged by TELUS for the 

electronic transfer. The online registration is made using your digital signature; data are automatically 

encrypted to be sent electronically. 

The registration function is used to transmit electronically mortgage deeds and deeds of 

acquaintance to the Land Register.  If necessary, you can add a Notice of Address to your deed, 

which will be transmitted simultaneously to the Land Register. 

 You can add up to two Notices of Address by electronic transfer. 

 To register a Microsoft Word document 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 



 

 159 

3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  A list of documents is displayed. A  sign is then displayed to 

the left of the category name meaning the list is expanded. 

4. Click the name of a document to select it. It is highlighted. 

5. Click the Register link on the right of the list of documents. 

 

 Note: The Register function is only enabled if the registration process can be done for the 

document that you have selected. 

This will open the Publish dialog box. You have to complete the information about the deed 

registration. 

 

 
Click to publish

Complete the information in 
the fields as explained

Click to cancel the 

process and close the 
window

Explanations on the 
way to complete the 

fields

Click to print the 
information in the 

window

Check to insert the 

TRUE COPY mention
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6. In the Date in Letters field, enter the deed's reception date. This information will be inserted 

into the document prior to sending it to the Land Register if you have not already indicated it 

in the Word document. 

7. In the Minute No in Letters and Minute No in Digits fields, enter the minute number. This 

information will be inserted into the document prior to sending it to the Land Register if you 

have not already indicated it in the Word document. 

8. To meet the needs of the online registration, complete the Date in Figures field. 

9. Check the  

 

 Note 1: if the mention  is ever in the document, the check box is disabled, so 

unchecked it. 

 Note 2:  is not in the document and the check box 

COPY he document is not 

complete and ready to be submitted to the Land Register. 

 

10. If you wish to have a printed version of the registration information, click the Print link at the 

bottom of the window. This will display the Windows Print dialog box.  Click the Print button 

to print the information. 

 Note: Click the Cancel button in the Publish window if you want to cancel the registration 

process. 

11. Click the Publish button at the top right corner to confirm the registration.  

If information is missing in the document, a message will be displayed and the registration 

process will abort. 

If nothing is missing, another window called Publish is displayed. 

From this window, you can add a Notice of Address to the deed you want to send for 

registration to the Land Register.  You can add up to two Notices of Address by electronic 

transfer. 

You have to complete at this stage the information about your digital signature and verify 

your payment information because you will be charged by TELUS for the electronic 

registration. 
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12. Click the Add button in the Notice of Address section. The window Import a document is 

displayed allowing you to import the Notice of Address you want to join to your deed. These 

documents will be transmitted simultaneously to the Land Register. You can add up to two 

Notices of Address by electronic transfer to the Land Register. 

13. In the Entrust Profile field, click the Browse button to look for the Entrust digital signature 

file. This will display another window called Choose File. Use the Choose File window to find 

and select your Entrust digital signature file.  

The Entrust digital signature file has an .epf extension. It must be available on your computer 

in a dedicated directory.  

Browse in your directories and files, select the Entrust file then click the Open button. This 

will close the Choose File window and will display the Entrust digital signature path and file 

name in the Entrust Key field of the Send for Registration dialog box. 

14. In the Password field, enter the password associated with your digital signature. 

15. In the Payment section, verify the information about your credit card number and expiry 

date. The Details section provides you with detailed information about the charges you have 

to pay.  
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If you update your credit card information at this stage, you can choose to keep this new 

information in your profile by clicking the Update my Profile check box. 

Refer to the Chapter 4, Modifying your Payment Information (Lawyers/Notaries only) section 

for more details on your profile and on your payment information. 

 If the data related to your credit card are erroneous, a message will be prompted. Make sure 

to enter the correct information. 

16. In the Land register Account No. field, enter your Land Register inscription number. 

 Click the Cancel button in the Register window if you want to cancel the registration process. 

17. Click on Preview button to see your document before you submit it to the Land Register. 

18. Click the Register button at the top right corner to confirm you want to send the document 

to the Land Register. Data are encrypted prior to be sent. 

The signature is automatically validated by the Notarius certification agent. 

When the transmission is completed and approved, the corresponding information is 

displayed in the Transmission Information section. You will find in this section the name of 

the recipient, its e-mail address and the sending date. 

 

A soft copy of the invoice is automatically generated and kept in the list of documents 

available for this file (see the Documents tab). You can open the invoice and print it.  

Afterward, you will receive an e-mail from TELUS confirming that your deed has been transmitted to 

the Land Register. You will also receive an e-mail from the Land Register confirming that the deed 

was received. You will finally receive later another e-mail from the Land Register providing you with 

the details of the registration of your deed. 

 Note: The registration expenses will be charged by the Land Register according to the usual 

rates and modalities. 

Add a Notice of Address 

This procedure applies when you want to add a Notice of Address to your deed in order to transmit 
them both simultaneously for publication to the Land Register. 
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 Add a Notice of Address 

1. Click on Publish button at the top right of the first window Publish to launch the registration 

process. You have previously filled the information in that window.  

2. The second window Publish is displayed. 

3. Click on the Add button to the right of the Notice of Address section to join a Notice of 

Address to the deed you want to send for registration to the Land Register. 

 

 

4. This will display the Import a document dialog box. You have to indicate in this window the 

complete path of the document to be imported. 
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5. Click the Import link to confirm the import. A confirmation message is displayed. 

 

 Note: Click the Cancel button in the Import a document window if you want to cancel the 

import process. 

6. Click the OK button to confirm the process and close the window.  

The imported document is added to the list in the Notice of Address section. You can join 

up to two notices of address to the deed that you transmit to the Land Register. 

7. Click the Preview button to view the document before you submit it to the Land Register. 

 

The deed will be followed by either one (1) or two (2) Notice of address.  Each Notice of Address will 

be separated by a black horizontal line. 

Repeat steps from 13 to 18 displayed in the section above Registering Documents Online to 

continue the transmission process to the Land Register. 

Registering PDF Documents (British Columbia Only) 

The registration process for PDF documents is done for British Columbia users through the BC 

Online interface. Users must have selected the Assyst Real Estate link and be logged, through BC 

Online, in the Assyst Real Estate system. 

The registration function is used to transmit electronically mortgage deeds. 

 To register a PDF document 

1. Select a file in your list of files. 
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2. Click the Documents tab. This will display the categories of documents available for the file. 

3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  A list of documents is displayed. A  sign is then displayed to 

the left of the category name meaning the list is expanded. 

4. Click the name of a document to select it. It is highlighted. 

5. Click the Register link on the right of the list of documents. 

   

 Note: The Register function is only enabled if the registration process can be done for the 

document that you have selected (mortgage deeds). The document must have been digitally 

signed. Data are encrypted prior to be sent. 

6. The registration process is executed. A status message is displayed. 

7. When the registration process is completed, a confirmation is displayed. 
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When the transmission is completed and approved, the corresponding information is displayed in the 

Transmission Information section. You will find in this section the name of the recipient, its e-mail 

address, the name of the sender and the sending date. 

Visualize document 

The Visualize button allows you to view your document as it has been registered to the Land 

Register. 

1. Select a file in your list of files. 

2. Click the name of the document to select it. It is highlighted. 

3. Click the Visualize button on the right of the documents section to view the document as it 

has been registered to the Land Register. 

 

 The «copie conforme» mention appears only in the document which was opened with 

Visualize button. 

Sending Documents 

The sending function is used to send a document electronically to a recipient. This is mainly used for 

title insurance requests. You can by this way send a request for a title insurance policy via Assyst 

Real Estate (to the Stewart Title company for instance). 

 To send a document 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 
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3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  

Select the Title Insurance Request category.  

4. Click the name of the document to select it. It is highlighted. 

5. Click the Send link on the right of the list of documents. 

  

 The Send function is only enabled if the sending process can be done for the document that 

you have selected. 

A confirmation message is displayed. 

 

6. Click the OK button to confirm the operation. Your request for a title insurance is 

automatically send to the Title company via Assyst Real Estate. 

The confirmation of the transmission process is displayed in the Transmission Information 

section. You will find in this section the name of the recipient, its e-mail address and the 

sending date. 

 

Deleting Documents 

The deletion function allows you to remove definitively a document from the list of documents of a file. 

This is only available for the documents that can be deleted, and that excludes the invoices, service 

contracts, rules and procedures, already registered reports, etc. 
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 To delete a document 

1. Select a file in your list of files. 

2. Click the Documents tab. This will display the categories of documents available for the file. 

3. Click the  sign to the left of a category name to display the generated documents 

belonging to this category.  A list of documents is displayed. A  sign is then displayed to 

the left of the category name meaning the list is expanded. 

4. Click the name of a document to select it. It is highlighted. 

5. Click the Delete link on the right of the list of documents.   

  

 The Delete function is only enabled if the deletion operation can be done and is authorized for 

the document that you have selected. 

A confirmation message is displayed. 

 

6. Click the OK button to confirm the deletion. The document is deleted and is removed from 

the list of documents. If needed, you can generate again a document that has been deleted. 

Save as documents 

The Save as button allows you to save a local copy of a generated document available in document 

section, without open this document before. 

1. Click the name of a document to select it. It is highlighted. 

2. Click the Save as link on the right of the list of documents. 
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3. Save as dialog box is displaying allow you to register the version of the document on your file 

system. 

Importing Word Documents 

Assyst Real Estate provides a function to import Word documents. This allows you to import in a file 

a document, with bookmarks, and register it online via Assyst Real Estate and transmit it to the Land 

Register for registration purpose.  

 To ensure that the document import works correctly, it is important for the document format 

to be in accordance with the TELUS specifications and contains bookmarks. 

The imported document is automatically added to the list of your documents for the current file under 

the Other documents (Import) category. 

 To import a Word document 

1. Select a file in your list of files. 

2. Make sure the File tab is selected. 

3. Click the Import a Word document link. 

 

Or 

4. Click the Documents tab. 

5. Click the Import a Word document link. 
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This will display the Import a Word document dialog box. You have to indicate in this 

window the name and the location of the file to be imported. 

 

6. Click the Browse button to select the document to be imported. This will display another 

window called Choose File. 

 

7. Use the Choose File window to find and select the document you want to import. 

Browse in your directories and files, select a file then click the Open button. This will close 

the Choose File window and will display the path and the name of the file to import in the 

Import a Word document dialog box. 

 

8. Click the Import link to confirm the import. A confirmation message is displayed. 
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 Note: Click the Cancel button in the Import a Word document window if you want to cancel 

the import process. 

9. Click the OK button to confirm the process and close the window.  

The imported document is added to the list of your documents under the Other documents 

(Import) category in the Documents tab. 

Working with Notes 

About Notes 

Notes included in files represent a means for financial institutions to add modifications to a file or 

special instructions until the access to the file is blocked. Only the information relative to the 

preferential and variable rate can be transmitted once the access to the file is blocked. 

Notes can also be used by you or your assistants to communicate information relative to the file, 

such as memos, statuses, etc.  

You can receive external notes or create yourself internal notes. 

All notes are kept with their files and once created, they cannot be deleted. 

It is important to read the notes associated to your files on a regular basis. By refreshing regularly the 

data of your files with the Refresh Files function, you will receive the new notes added to your files 

(by the financial institutions or by your assistants). If a file includes a new note that is not read, it is 

identified with a blue color in the list of your files and has the  symbol displayed to its right side. The 

financial institutions that include in their list files with notes that are not read have also the  symbol 

displayed to their right side. 

Notes are all accessible from the Notes tab. You can consult them at any time 

Consulting Notes 

Notes are all accessible from the Notes tab. You can consult them at any time.  

If a file includes a new note that is not read, it is identified with a different blue color in the list of your 

files and has the  symbol displayed to its right side. The financial institution that includes in its list 

files with notes that are not read have also the  symbol displayed to their right side.  
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Consulting Notes 

 To consult notes 

1. Select a file in your list of files. 

2. Click the Notes tab. This will display the list of notes for this file. All notes are displayed with 

their subject. The detail of each note is not displayed automatically.   

 

3. Click to select a note and display and expand its text. Repeat the process for all the notes 

you want to consult. The text of every note is displayed in a yellow border box. 

4. Click again a note to hide its text. Only the subject is displayed again. 
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 Note: You can click in the list of your current files to select another file and keep the Notes 

tab active. The notes for the every file selected file are then displayed. 

Note Description 

The note page provides the following information: 

Field Description 

 Symbol Indicates that the note has not been read 

 Symbol Indicates that the note has been read 

Subject Subject of the note 

Role Role of the sender of the note in the system 

Reception Date Reception date of the note in the file 

Modification Date Date the note was lastly modified. 

Status Note status: read or not read. 
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Marking a Note as Read 

When you have consulted a note, you can indicate that you have read it. The note cannot be 

modified once it is marked as "Read" if it was note that you had created yourself. 

 To read a note 

1. Select a file in your list of files. 

2. Click the Notes tab. This will display the list of notes for this file. 

3. Note: If a file includes a new note that is not read, it is identified with a blue color in the list of 

your files and has the  symbol displayed to its right side. 

4. Click to select a note not yet read and display and expand its text.  

5. Note: A note that has not yet been read has a  symbol to its left side. 

6. Click the I Read this Note link. 

 

7. This will display a message asking you if you want to generate again the specific mandate. 

8. Click OK or Cancel depending if you want to generate again the specific mandate or not. 

The I Read This Note box is now checked. 

The note now displays a  symbol on its left side. The note cannot be modified once it is 

marked as "Read" if it was note that you had created yourself 

 Note: If it was the last not read note, the file is then displayed with no specific symbol (the   

symbol is no longer displayed on its right side) 

Adding Notes 

You can yourself add a note to a file to transmit information or keep a track of information. 
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The addition of a note can be done from two different pages in Assyst Real Estate, either from the 

File tab or from the Notes tab.  

 To add a note to a file 

Method 1: 

1. Select a file in your list of files. 

2. Make sure the File tab is selected. 

3. Click the Add a Note to File link. This will open the Add a Note dialog box.  

 

4. Enter the subject of your note in the Subject field.  

5. Enter the text of your note in the Note box. 

6. Click the Save button to save your new note and close the Add a Note dialog box. The new 

note is added to the file. It is marked as "Not Read". 

Method 2: 

1. Select a file in your list of files. 

2. Click the Notes tab. This will display the list of notes for this file. 

3. Click the Add a Note link on the top right side of the note page. 

 

This will open the Add a Note dialog box. 
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4. Enter the subject of your note in the Subject field.  

5. Enter the text of your note in the Note box. 

6. Click the Save button to save your new note and close the Add a Note dialog box. The new 

note is added to the file. It is marked as "Not Read". 

 Note: Click the Cancel button in the Add a Note dialog box if you want to cancel the creation 

of the note. 

 Note: When a note is created, either by you or by the system, a copy of the note content is 

automatically sent to the e-mail address defined in the Office E-mail field of the My Profile 

page. 

For more details on your profile, refer to the Managing Your Profile section. 

Modifying Notes 

You can modify a note that you created yourself and add additional information. You cannot modify a 

note once it is marked as "Read". You cannot modify a note created by someone else, especially 

those received from the financial institutions. 

 To modify a note 

1. Select a file in your list of files. 

2. Click the Notes tab. This will display the list of notes for this file. 

3. Click to select a specific note and display the text of this note. You can only modify a note 

that you created yourself and as long as the note is not marked as "Read". In the other 

cases, the modify function is not available. 

Enter the subject 

of the note

Enter the text of 

the note

Click to 

save the 

note
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4. Click the Modify link. 

5. This will open the Add a Note dialog box. 

6. You can modify the text of the note (Note) or the subject (Subject) and add additional 

information. 

7. Click the Save button to save your modifications and close the Add a Note dialog box. 

The note is then updated with your modifications. 

Printing Notes 

You can print the notes of your files at any time. You just need to display the note page and to select 

the printing function. 

 To print a note 

1. Select a file in your list of files. 

2. Click the Notes tab. This will display the list of notes for this file. 

3. Click to select specific notes and display the text of these notes. 

4. Click the Print link on the top right side of the page. 

 

This will display the Windows Print dialog box. 

5. Select your printing parameters in the dialog box then click the Print button. This will start the 

printing process. 

 The page will be printed the way it is displayed meaning with the notes whose texts are 

displayed and those that are hidden. 

Transferring Files (Quebec Only) 
The Transfer function is only available for files processed in the Quebec province. 

Thanks to the transfer function, you can transfer a file to another lawyer/notary if, for any reason, you 

are not able to handle the file. 
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A file can be transferred to another lawyer/notary only if it has not yet started to be processed. Its 

status must be set to File Accepted to be able to transfer it.  

When you transfer a file, you are automatically reimbursed by TELUS and the charges for the file are 

credited to your credit card. 

When a file is transferred, it is removed from your list of current files. 

 To transfer a file 

1. Select a file in your list of files. 

2. Make sure the File tab is selected. 

3. Make sure the file status is set to File Accepted in the Status section. If not, transfer will fail. 

4. Click the Transfer File link below the Status zone. 

 

This will display the Transfer File dialog box. 
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5. Click the  button to display the Legal Counsel Search dialog box. 

 

6. Complete the criteria for your search by selecting the Province and the City (if desired) and 

by entering the first 2 letters of the Name of the legal counsel to whom to you want to 

transfer the file. 

Click to start the transfer 

process, once the name of 

the legal counsel is selected

Verify the information 

about your credit card 

for the reimbursement

Check the box to update 

your profile with the 

information about your 

credit card

Click to select the name of the 

legal counsel  to whom the 

document will be transfered

Complete the criteria for your 

search. You must select a 

province and enter the first 2 

letters of the name of the legal 

counsel you are looking for

Click to perform the search

Results of the search

Click to select the name of 

the legal counsel to whom 

you want to transfer the file
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7. Click the Search button to perform the search.  

A message is displayed if no record matches your criteria. 

 Note: If the name of the lawyer/notary to whom you want to transfer the file is not listed, 

please contact the Assyst Real Estate Service Desk. 

8. The results of the search are displayed in a list.  

9. Select the name of the legal counsel you are looking for.  

Use the scroll bar to move up and down in the list.  

10. The Legal Counsel Search dialog box is closed and the name you selected is automatically 

added to the Transfer File dialog box. 

 

11. Verify or complete the information relative to your credit card (credit card number and expiry 

date) for the reimbursement of the charges for the file. The information that is displayed 

comes from your profile. 

If you update your credit card information at this stage, you can choose to keep this new 

information in your profile by clicking the Update my Profile check box I. 

 Note: If the data related to your credit card are erroneous, a message will be prompted. Make 

sure to enter the correct information. 

Refer to the Modifying the Payment Information section for more details on your profile and on your 

payment information. 

12. Click the Transfer button to confirm the transfer. A confirmation message is displayed. 

13. Click the OK button to confirm the process and close the window. 

The file is then transferred and removed from your list of files. 

 Note: Click the Cancel button in the Transfer File window if you want to cancel the transfer 

process. 

 Note: You can generate at any time the transaction report to view the transaction that has 

been completed. The operation will have the Acceptance description but the amount will be 

negative and will represent a credit for you. For more details on the transaction reports, refer 

to the Working with Transaction Reports section. 
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Exporting Files 
Assyst Real Estate provides you with an export function to allow you to export a file and its data in 

order to use them with a third party software.  

 Note: So that the export works correctly, it is important for your third party software to be 

compatible with the TELUS specifications (XML specifications). Indeed, the file data are 

exported in an XML file format that your third party software must be able to import  

 To export a file 

1. Select a file in your list of files. 

2. Make sure the File tab is selected. 

3. Click the Export File link below the Status zone. 

 

This will display the Export File window.  

This window provides you with information about the export file. Your file data are exported 

in a XML file format that is copied locally on your computer in the directory that is indicated. It 

is this file that you can import from your third party software. 

 

4. Click the Export button on the top right side of the window to confirm the export process. A 

confirmation message is then displayed.  
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5. Click the OK button to confirm the process and close the window. All your file data are saved 

in a XML file and copied to your hard disk to be used by your third party software. 

 Note: Click the Cancel button in the Export File window if you want to cancel the export 

process. 

Canceling Files 
If you have to cancel a file, it is recommended to contact the financial institution which transmitted 

you the file to be informed about the procedure to be followed. 

 To cancel a file 

1. Select a file in your list of files.  

2. Make sure the File tab is selected.  

3. Click the Cancel File link below the Status zone. 

 

A message is prompted asking you to contact the financial institution which transmitted you 

the file to be informed about the procedure to be followed. 

 

4. Click the OK button to close the window and come back to your files.  

5. Contact the financial institution to be informed about the details of the canceling process. 

Closing Files 
You can close a file when its processing is completed and when the final report has been sent to the 

financial institution. 

Once closed, a file is removed from the list of your files. You can still consult it by launching a search 

with the Search for Files function, but the file must have been closed for less than 6 months. For 

more details on the searching options, refer to the Searching for Files section. 
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Make sure to keep a copy of your documents and to have the latest version of the specific mandate 

before closing a file because you will not be able to access once it will be closed. 

Closing a File 

The electronic closing of a file is done by checking the File Closed box in the Status section in the 

File page. 

 To close a file 

1. Select a file in your list of files.  

2. Make sure the File tab is selected.  

In the Status section, you can observe that every step required in the file processing has 

been completed and is checked, except for the File Closed check box. 

3. Click the File Closed link to check the box.  

 

The file is closed and removed from your list of files. A notification is sent to the financial 

institution. 

Automatic File Closing 

A file is automatically closed in Assyst Real Estate and removed from your list of files 6 months after 

the final report has been signed and sent. 

Creating Files (Quebec Only) 
The Create File function is only available for files processed in the Quebec province.  You can create 

your own files on Assyst Real Estate particularly for:  

 Import deeds with bookmarks with the help of the Assyst Real Estate Toolbar that is 

available on the Inforoute Notariale and then register online these deeds by sending them to 

the Land register via Assyst Real Estate.  
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 Create a Discharge file and then register online this Discharge file by sending it to the Land 

register via Assyst Real Estate. (Refer to the Chapter 7 Discharge for more details). 

 Order Title Insurance from the registered title insurer.  

The files that you create yourself are added to your list of files under the Other Files category. 

 To create a file 

1. Click the Create File button in the Assyst Real Estate toolbar. 

 

This will display the Create File window.  

 

2. Select in the scroll down menu the program you want to create a folder (ex: Publication 

(only), Refinancing, Purchase/Sale, Switch, New loan, Discharge) 

3. Select in the scroll down menu the name of the Financial Institution to which the file will be 

associated. 

 If you select the program Publication or the program Discharge, the field Name will be grayed 

out and you can not select the name in the Name field. 

4. Enter the name of the natural or legal person (Appearer) to which the file will be associated.  
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5. For legal assistants only: select in the Legal Counsel Responsible for the file list the name 

of the lawyer/notary you work for and who is responsible for the file. 

 Note: The Legal Counsel Responsible for the file field is only displayed for legal assistants. 

6. Select in the scroll down menu the Province of the property associated to the file 

7. Click the Create button.  

The file is added to the list of your files in the Other Files section.  

 

8. Import the Word documents that will be included in the file by using the Import a Word 

Document function. These imported documents have to be deeds with bookmarks from 

Assyst Real Estate Toolbar.  

Your documents are added to the list of documents in the Documents tab; or 

9. Prepare a Discharge file. 

10. You can then register the documents you have imported using the standard Register 

function available in the Documents tab. Refer to the Registering Documents Online section 

for more details. 

You can add notes to your files using the Add a Note function. Refer to the Adding Notes section for 

more details. 

Close the file when all documents have been registered by checking the File Closed box in the 

Status section of the File tab. 

 Do not accumulate too many documents in one single file, make separate files. 

 


